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WARRANTY POLICY 
Photon’s products are covered by limited warranty on parts and labor for 12 months from shipment date and13 
months if shipped to an authorized representative except as noted below.  This warranty covers parts and 
labor to repair the equipment that fails to perform due to problems that are innate to the units and its 
components, but not due to neglect or misuse.  Photon cannot be held liable for any damages beyond the 
original equipment cost. 

Photon does not warrant incorrect use of instruments such as but not limited to: 

  Connecting or disconnecting a Photon sensor head or a plug-in card with the computer or Photon 
controller powered on. 

  Plugging a Photon sensor head into a game port. 

  Plugging your Photon controller or your computer into a wall outlet without a surge protection strip. 

Photon reserves the right to determine if the problem has been brought on by improper use. 

Photon DOES NOT WARRANT DAMAGE TO APERTURES OR DETECTORS FOR ANY REASON. This 
includes but is not limited to the following: contamination, laser damage, puncture to apertures, melted 
apertures, cut apertures, melted or cut detectors, or slit or detector damage by intense laser beams for any 
reason.   

The silicon array sensors shipped without a cover glass are not warranted for any reason.  Sensors 
should never be cleaned.  

Optical components such as the ATP series have a 15-day warranty on materials and workmanship.  Photon 
does not warrant damage from shipping, mishandling or laser damage for any reason. 

Whenever Photon sensors are ordered alone without a Photon control card or Photon software, the warranty is 
rendered void. 

Warranty is not transferable except through resale of products by authorized agents of Photon inc.  
Unauthorized transfer of equipment and/or any modifications to the equipment are grounds for voiding 
warranty coverage. 

Photon reserves the right to void the warranty, if the Buyer fails to meet the terms of purchase such as, but 
not limited to, a payment after the stated agreed invoice payment date or failure to pay for shipping charges as 
examples. 

This is Photon’s sole warranty with respect to its products.  No statement, agreement or understanding, oral or 
written, made by an agent distributor, representative or employee of Photon, which is not contained in this 
warranty will be binding upon Photon, unless made in writing and executed by an officer.  Photon makes no 
other warranty of any kind whatsoever, expressed or implied, and all implied warranties of merchantability and 
fitness for particular use, which exceed the aforementioned obligation, are hereby disclaimed by Photon and 
excluded from this agreement.  Under no circumstances shall Photon be liable to Buyer in contract or in tort, 
for any special, indirect, incidental or consequential damages, expenses, losses or delays however caused. 

Photon must be notified of any defect or nonconformity, and the defective product must be returned to 
Photon’s factory or an authorized service center, within the warranty period.  All shipments to Photon must 
be freight prepaid.  A “Return Material Authorization” (RMA) number is required on all returned items.  
Warranty repairs will be returned pre-paid via UPS ground shipment.  If a faster return is desired the Buyer 
must pay for the shipping charges.  
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Software License Agreement 
This legal document is an agreement between you, the end user, and Photon Inc. BY OPENING THE SEALED SOFTWARE 
PACKAGE, YOU ARE AGREEING TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT, WHICH INCLUDES 
THE SOFTWARE DISCLAIMER OF WARRANTY (collectively the “Agreement”). 
THIS AGREEMENT CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU AND PHOTON INC. IF YOU DO 
NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT OPEN THIS PACKAGE. PROMPTLY RETURN THE 
UNOPENED PACKAGE AND THE OTHER ITEMS (INCLUDING WRITTEN MATERIALS AND BINDERS OR OTHER 
CONTAINERS) THAT ARE PART OF THIS PRODUCT, TO THE PLACE WHERE YOU OBTAINED THEM. 
THIS AGREEMENT INCLUDES ALL MATERIALS PROVIDED IN THE SEALED SOFTWARE PACKAGE INCLUDING 
ALL MATERIALS PRODUCED, MANUFACTURED, DISTRIBUTED, PACKAGED, BUNDLED OR OTHERWISE 
INCLUDED BY PHOTON INC. IN THE SEALED SOFTWARE PACKAGE INCLUDING SOFTWARE FROM OTHER 
VENDORS, MANUFACTURERS, DEVELOPERS AND SUBCONTRACTORS. 

Photon Inc. Software Site License 

1. GRANT OF LICENSE. This product consists of software to be used with any Photon Inc. instrument product; e.g., 
NanoScan, ModeScan, USBeamPro, FireWire BeamPro, BeamScan, BeamProfiler, Goniometric Radiometers. In 
consideration of payment of the license fee, which is part of the price you paid or agreed to pay upon receipt of the invoice 
from Photon Inc. for this product, Photon Inc., as LICENSOR, grants to you, as the LICENSEE, a personal, nonexclusive 
license to make and use copies of the applicable Photon Inc. instrument analysis software program (hereinafter, “PHOTON 
SOFTWARE”). You may install copies of PHOTON SOFTWARE on an unlimited number of computers at a single 
location, providing that only one individual at a time is using the PHOTON SOFTWARE. If you are an entity, Photon 
grants you the right to designate one individual within your organization to have the right to use the PHOTON SOFTWARE 
in the manner provided above. Photon Inc. reserves all rights not expressly granted to LICENSEE. 

2. OWNERSHIP OF PHOTON SOFTWARE. As the LICENSEE, you own the magnetic or other physical media on which the 
PHOTON SOFTWARE is originally or subsequently recorded or fixed, but Photon Inc. retains title and ownership of the 
PHOTON SOFTWARE recorded on the original disk or tape and all subsequent copies of PHOTON SOFTWARE, 
regardless of the form or media in or on which the original and other copies may exist. This license is not a sale of the 
original PHOTON SOFTWARE or any copy. 

3. COPY RESTRICTIONS. This PHOTON SOFTWARE and the accompanying written materials are copyrighted. 
Unauthorized copying of the PHOTON SOFTWARE is expressly forbidden. You may be held responsible for any 
copyright infringement that is caused or encouraged by your failure to abide by the terms of this License. Subject to these 
restrictions, and if the PHOTON SOFTWARE is not copy-protected, you may make up to three (3) copies of the PHOTON 
SOFTWARE solely for backup purposes. You must reproduce and include the copyright notice on the backup copy. 

4. USE RESTRICTION. As the LICENSEE, you may physically transfer PHOTON SOFTWARE from one computer to 
another, provided that the PHOTON SOFTWARE is used by one individual at a time at one location. 

5. TRANSFER RESTRICTIONS. This PHOTON SOFTWARE is licensed only to you, the LICENSEE, and may not be 
transferred to anyone without the prior written consent of Photon Inc. Any authorized transfer of the PHOTON 
SOFTWARE shall be bound by the terms and conditions of this Agreement. In no event may you transfer, assign, rent, 
lease, sell, or otherwise dispose of the PHOTON SOFTWARE on a temporary or permanent basis except as expressly 
provided herein. 

6. TERMINATION. This license is effective until terminated. This license will terminate automatically without notice from 
Photon Inc. if you fail to comply with any provision of the License. Upon termination you shall destroy the written 
materials and all copies of the PHOTON SOFTWARE. 

7. UPDATE POLICY. Photon Inc. may create, from time to time, updated versions of the PHOTON SOFTWARE. At its 
option, Photon Inc. will make such updates available to the LICENSEE. 

8. MISCELLANEOUS. This agreement is governed by the laws of the State of California. 
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Disclaimer of Warranty and Limited Warranty 

THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIAL (INCLUDING INSTRUCTIONS FOR USE) ARE 
PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND. FURTHER, PHOTON INC. DOES NOT WARRANT, 
GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF THE USE, OF 
THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, 
CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE 
SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU, AND 
NOT PHOTON INC. OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF 
ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 
Photon Inc. warrants to the original LICENSEE that the medium on which the SOFTWARE is recorded is free from defects in 
materials and workmanship under normal use and service for a period of ninety (90) days from the date of delivery as evidenced 
by a copy of the receipt. If failure of the medium has resulted from accident, abuse, or misapplication, Photon Inc. shall have no 
responsibility to replace it or refund the purchase price. Any replacement disk or tape will be warranted for the remainder of the 
original warranty period or thirty (30) days, whichever is longer. 
THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPESSED OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, THAT ARE MADE BY PHOTON INC. ON THE PHOTON INC. PRODUCT. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY PHOTON INC., ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES 
SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY 
NOT RELY ON ANY SUCH INFORMATION OR ADVICE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. 
YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE. 
NEITHER PHOTON INC. OR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR 
DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR 
INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OF OR INABILITY TO USE SUCH 
PRODUCT EVEN IF PHOTON INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE 
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 
This Disclaimer of Warranty is governed by the laws of the State of California. 
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11..  INTRODUCTION 

1.1. System Overview 

1.1.1. USBeamPro CCD Model 2312 

The Model 2312 USBeamPro CCD system is a PC based optical beam 
profiling system offering a unique combination of performance and ease of use. 
Highly accurate measurements can be made on both pulsed and CW lasers, 
over a wide range of wavelengths, beam diameters, and power/energy levels. 
Sophisticated, yet simple, Microsoft Windows-based software allows these 
results to be displayed, analyzed and/or archived in real time at video rates. 

The USBeamPro CCD Model 2312 includes the USB2.0 CCD Camera and 
the USBeamPro CCD Acquisition and Analysis Software. 

1.1.2. USBeamPro Acquisition and Analysis Software 

The USBeamPro CCD Software is written for Microsoft Windows XP 
Professional (32-bit), Microsoft Windows Vista Business (32-bit) or Microsoft 
Windows 2000 Professional and takes full advantage of the menu driven, 
multi-windowing environment.  
Windows available for data display include: 

♦♦  Video window Displays live video images; 
♦♦  Dual Aperture 

Profile window 
Displays pinhole or slit profiles; 

♦♦  Beam Statistics 
window 

Displays computed beam parameter 
values and statistics; 

♦♦  3D Profile View 
windows 

Displays 3-dimensional 
representations of beam intensity; 

♦♦  2D Contour View 
windows 

Displays 2-dimensional contours of the 
beam intensity; 
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♦♦  Time Statistics 
windows (up to 15) 

Displays strip chart graphs of selected 
beam parameters; 

♦♦  Pointing window Displays a target screen for observing 
beam pointing and divergence; 

♦♦  K-Factor (M²) 
window 

An interactive K-Factor Wizard 
program for measuring K-factor (M²) 
by the Rayleigh Method; 

♦♦  Notes window A simple text editor for entering user 
annotations; 

The software also performs rigorous data analysis over specific regions-of-
interest (ROIs) in accordance with the ISO standards. The ROIs can be 
either system or user defined. Quantitative measurement of numerous beam 
spatial characteristics is possible. Pass/Fail limit analysis for each of these 
parameters can be also applied. 
Parameters measured include: 

♦♦  Beam width 
♦♦  Centroid and peak location 
♦♦  Major and minor axes 
♦♦  Beam orientation 
♦♦  Ellipticity, eccentricity 
♦♦  Gaussian fit 
♦♦  Beam uniformity 
♦♦  Beam divergence 
♦♦  Pointing stability 
♦♦  M², K-factor 

For data visualization, the user can arrange and size multiple windows as 
required. These may contain, for example, live video, calculated beam 
parameters and summary statistics in the form of graphs, tables, 3D views 
and strip chart time displays. These user instrument views can be saved as 
files for future use. 
Data can be exported to spreadsheets, math and statistical analysis 
programs and process/instrumentation control programs by logging to files 
or COM ports, or by sharing using ActiveX Automation. 
Live video of both pulsed and CW laser beams can be viewed in false color 
or gray scale. False color options include rainbow and four monochrome 
colors. This allows the user to choose a display color that can be seen 
clearly while wearing laser goggles. Beam profiles through the centroid, the 
peak or user defined points can be displayed. Profile orientation can be 
either in the horizontal and vertical axes or along the major and minor axes 
of elliptical beams. 
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Hardware and software installation instructions, the features of the software, 
operating hints and answers to frequently asked questions are presented in 
this operating manual. In addition, you can refer to the extensive on-line 
Help menu of the BeamPro Analysis Software program for this information. 

Finally, to take full advantage of the features of the software, it is assumed 
that users have a working knowledge of the Windows operating systems 
and are familiar with basic Windows features such as opening, closing and 
saving files, making menu selections, opening, arranging, and resizing 
windows, etc. If these procedures are not familiar, see the Windows online 
Help, accessed by clicking on the Start button and selecting Help, or refer 
to numerous available Microsoft Windows manuals and tutorials. 

1.2. Model 2312 Camera Specifications 
  Interface:  USB 2.0 
  USB Connector: USBB 
  USB Cable:  USB B USB A 
  Sensor:  1.3 MegaPixel CCD 1/2”  
  Wavelength Range Standard: 350–1100nm 

 Optional: 190–1100nm 
  Image Plane 4.826mm from front surface 
  Effective Pixel Elements: 1360 (H)  1024 (V) 
  Pixel Size:  4.65µm  4.65µm 
  Array Dimension: 6.32mm  4.76mm 
  Scanning Mode: Progressive 
  A / D Conversion: 12 Bit 
  Maximum Frame Rate: 10 frame per second  

(full resolution) 
  Exposure range: 50µs to 100ms 
  Trigger:  Internal or External   

   (Software selectable) 
  External Trigger Specifications: TTL (Positive transition) 

  HIGH Level:  2 to 5 VDC 
  LOW Level:   -0.3 to 0.8 VDC 

  Trigger Connector:  DIN 8 
  Trigger Cable:  DIN8 to BNC 
  Dimensions, W  L  H:  70mm  95mm  33mm 
  Weight   298g 

  Lens Mount Type:  C-mount 
  Operating Temp:  0° to 50C 
  Supply Voltage:  4.40 to 5.25 V supplied by  

    USB 2.0 interface 
  Supply Power:  <1.6 W 
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22..  System Inspection 

2.1. Inspection 

If you did not inspect the shipping container prior to 
unpacking, please do so now before going any further. 

Your USBeamPro CCD system has been carefully tested, inspected and 
packaged prior to shipment. Photon performs extensive testing to ensure that the 
unit is in proper working order. Upon receipt, please inspect your USBeamPro 
CCD system for the following: 

♦♦  Note any damage to the shipping container. Please report any 
damage found immediately to the shipping company. Photon 
does not warrant damage that occurs as a result of shipment. 

♦♦  Check the contents of your shipment against the packing slip 
attached to the shipping box. Please note any discrepancy. 

♦♦  A warranty form is included with all new units. Please complete 
this form and return it to Photon to activate your warranty. 

2.2. USBeamPro CCD System Packing List 
The following items are shipped as part of the 2312 USBeamPro CCDBeam 
Profiling System: 

♦♦  Model 2312 1/2” USB 2.0 CCD Camera 
♦♦  USBeamPro CCD Acquisition and Analysis Software CD for 

Microsoft Windows XP Professional (32-bit), Microsoft Windows 
Vista Business (32-bit) or Microsoft Windows 2000 Professional 

♦♦  USB A to USB B cable 
♦♦  DIN8 to BNC external trigger cable 
♦♦  Operating Manual 
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33..  SYSTEM SETUP 

3.1. Personal Computer Requirements 
To ensure the successful installation and operation of the USBeamPro 
system, verify that your PC has the following minimal requirements: 

♦♦  1.8GHz or faster Pentium IV Processor 
♦♦  Microsoft Windows Vista Business (32-bit edition), Microsoft 

Windows XP Professional SP2 (32-bit edition) or Microsoft 
Windows 2000 Professional SP4 Operating System 

♦♦  USB 2.0  
♦♦  512 MB of RAM  
♦♦  CD Drive 
♦♦  30MB free space on hard disk 
♦♦  SVGA Display Monitor 
♦♦  64MB Color SVGA Graphics Card 
♦♦  Mouse or other Pointing Device 
♦♦  Keyboard 

3.2. Installation 
There are two steps to install the USBeamPro CCD Acquisition and analysis 
software. 

1. Software Installation 
2. Camera Driver installation 

Do not attach the camera to the PC until, after installing the software. 
Note: In order to properly install and configure the camera and/or the 
software you will need Administrator Rights. (Please contact your system 
administrator for details regarding the Administrator Rights). 
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3.2.1. Software Installation 
1. Insert the installation CD. 
2. The installation software will run automatically 

• Windows Vista only: by default vista will ask before 
running setup, choose run setup.exe 

3. Follow the on screen instructions, and the software will begin 
installing. 
• Windows Vista only: by default vista will ask for 

confirmation of actions that require administrative rights; 
select allow for any User Account Control (UAC) 
dialogs. 

4. When the software has finished installing, choose finish. 

3.2.2. Driver installation 
There are two situations where the driver will need to be installed: 

1. The initial installation occurs when the camera is first 
attached to the PC. 

2. Subsequent installations occur when the camera is attached 
to a specific USB port for the first time; however the 
installation process is simplified. 

3.2.2.1 Initial driver installation: 
1. Attach the USB cable to the camera, and to the PC 
2. Windows will automatically detect the camera and start the 

Found New Hardware Wizard. 
• Windows 2000 

• Choose the “Search for a suitable driver …” option 
• Choose Specify Location. 
• Choose Browse. 

• Windows XP 
• Choose No, not at this time 
• Choose Install from List or specific location 
• Choose Specify location 
• Choose Browse. 

• Windows Vista  
• Choose the “Locate and install suitable driver …” option 
• Choose Accept to the UAC prompt. 
• Choose the “I don’t have the Disk …” option 
• Choose Browse my computer 
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3. In the browse dialog: Navigate to the folder the software was 
installed and choose the driver folder, by default this is 
“C:\Program Files\Photon\USBeamProCCD\Driver” If a different 
location was chosen during the software installation, navigate 
to that location, and select the driver folder. 

4. Choose next 
• Windows XP and Vista: A warning will appear explaining 

that the dirver is unsigned, Choose Install Anyway. 
5. Follow any additional on screen directions, and wait while the 

driver is installed. 
6. When the installation is complete choose finish, or close as 

appropriate. 

3.2.2.2 Subsequent installations:  
• Windows 2000 and Vista The driver will be re-installed 

automatically without additional user intervention. 
• Windows XP 

• Choose No, not at this time 
• Choose the “Install driver automatically …” option 
• Choose Continue Anyway 
• Choose Finish 

The software is ready to use at this point. 

3.3. Software Uninstallation 
The software can be uninstalled via the Add/Remove Programs option in the 
control panel. 

1. Open the Control Panel 
2. Choose Add/Remove Programs  

• Vista Only: the option was renamed Programs and 
Features 

3. Locate and select USBeamPro CCD in the list 
4. Choose Uninstall, or Remove as appropriate. 
5. Follow any onscreen directions. 
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44..  ACQUISITION AND ANALYSIS 

SOFTWARE 

4.1. Quick Start 

4.1.1. Starting the Program 
To run the USBeamPro CCD Acquisition and Analysis Software program: 

From the Windows Start menu, select Programs, then Photon, and then 
USBeamPro or select the USBeamPro icon from your desktop. 

After installation when the program is first started, the Video window will 
appear. At this point the program GUI can be configured as desired with the 
multiple windows available. Alternatively, a sample startup GUI configuration 
screen is available that can be opened from the File menu. The sample 
configuration file name is “Example.usc” and can be found in the directory 
where the software was installed, (default directory is “C:\Program 
Files\Photon\USBeamPro”). There are 6 windows on this sample screen, 
including: 

♦♦  Video window 

♦♦  Profile window 

♦♦  Beam Statistics window 

♦♦  3D Profile window 

♦♦  Pointing window 

♦♦  Notes window 
Figure 4.1 shows the Example.usc configuration screen and the arrangement 
of these 6 windows.  
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Figure 4.1. “Example.usc” Configuration Screen. 

 

The software has 2 Acquisition Modes for image acquisition and 
processing. These are accessed under the Data Collection menu or through 
the icons from the main toolbar: 

 Laser Positioning: used for positioning the 
laser beam in the sensor aperture as shown in 
the Video window; 

 Analysis: used to obtain Beam Parameters on 
a continuous basis; 

At first startup, the system is in Laser Positioning Acquisition Mode. 
The software has 3 Trigger Modes, accessed under the Data Collection 
menu: 

♦♦  CW for CW lasers; 

♦♦  Pulsed  for Pulsed lasers where an external sync trigger is 
NOT available; 

♦♦  External for Pulsed lasers where an external sync trigger is 
available. 

At first startup, the system is in CW Trigger Mode. 
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4.1.2. Position the Laser Beam in the Aperture. 
To begin collecting data, select Global Data Collection from the Data 

Collection menu, or alternatively, use the  icon on the toolbar, or depress 
the Ctrl+G ‘Hot Key’. The Video window will now be displaying data. The 
other windows will remain blank because data processing is inhibited in 
Laser Positioning mode to provide the fastest video update. 

Adjust the laser beam steering or the camera position until the beam image 
is centered in the aperture as viewed in the Video window. The Video 
window uses false color schemes to code the beam intensity. The default 
scheme is the ‘rainbow’ spectrum, with low intensity toward the violet and 
high intensity toward the red. White indicates a saturation condition. If the 
beam is too intense and saturation is observed, attenuation will be needed. 
To fully utilize the system dynamic range and achieve the specified accuracy 
in beam measurements, either adjust the laser intensity to a level just below 
the saturation level using attenuators, or use the Camera Settings Dialog to 
adjust the Exposure Time. 

4.1.3. Trigger Mode for Pulsed Lasers 
If your laser is CW, skip this step. 

To measure pulsed laser beams, use either the External Trigger Mode or the 
Pulsed Trigger Mode. These trigger modes are discussed below. If you can 
provide an external trigger, the best way to measure pulsed laser beams is 
using the External Trigger Mode. External triggering requires a TTL signal, 
with the trigger occurring on the positive-going (leading) edge. The external 
trigger cable provided with the system connects to the camera with a Hirose 
connector and has a BNC connector for the TTL signal input. 

If you cannot provide an external trigger, use the Pulsed Trigger Mode. 
When this mode is selected, the software will automatically determine the 
presence of the beam based on minimum signal amplitude of 32 counts out 
of 4096. In this mode, the update rate will, in general, be reduced from that 
obtainable using the External Trigger Mode. The Trigger Mode can be 
changed through the Data Collection menu using the mouse. Open the 
Trigger Mode menu and select either Pulsed or External. 
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4.1.4. Calibrate the System 
It is necessary to perform a calibration prior to making beam measurements 
to obtain the specified accuracy. To calibrate, select Calibration from the 
Data Collection menu. The Camera Calibration dialog box will appear. 

In the user interface, there are two visual indicators (the calibration icon on 
the main toolbar and the message in the last pane of the Status Bar), which 
changes depending on the system calibration status. The icons change to 
indicate the status of calibration, as follows: 

 
System Uncalibrated 

 
System Settings Changed since last calibration 

 
System Calibrated under current system settings 

System settings include camera exposure, trigger mode, and unit serial 
number. 

If the last pane of the status bar displays the message “Calibration conditions 
changed” or the calibration icon corresponds to the “System settings 
changed” the system has been calibrated, but that something about the 
measurement configuration has changed; either the exposure, the trigger 
mode, or the unit serial number. In this case it is recommended to recalibrate. 

To calibrate, use the displayed Calibrate icon,    on the main 
toolbar or select Calibration from the Data Collection menu. The Camera 
Calibration dialog box will appear. 

 
Simply follow the directions. Block the beam (as far from the camera aperture 
as possible) and click the Calibrate button. Then click on the OK button. This 
completes the calibration procedure. 
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4.1.5. Switch to Analysis Mode 
To start measuring Beam Parameters, the system must be set to Analysis 
Mode. The Analysis Mode can be set by selecting Acquisition Mode from 
the Data Collection menu and clicking on Analysis. 

 

Alternatively, use the  icon on the toolbar. The Profile, Beam Statistics, 
and 3D Profile windows will now display data and images. 

4.1.6. Beam Parameters - Computation and Display 
4.1.6.1. Computation of Parameters 
Beam parameters are computed when the system is operating in the 
Analysis Acquisition Mode. The computations that are performed are 
determined by selections made in the Data Analysis dialog. To optimize the 
data update rate, all computations are done on a subset of the entire video 
image called the Beam Area. The number of pixels in the Beam Area that 
are actually used in the calculations are determined by the Acquisition 
Resolution. The computations also use the effective pixel dimensions and 
the Magnification Factor. 

4.1.6.2. Beam Area 
If the system is set for Auto Track, the Beam Area is automatically 
determined to include the entire laser beam image but to be of minimal size. 
(This is to minimize the computation time by keeping the Beam Area as small 
as possible.) If the system is not set for Auto Track, a Beam Area must be 
set manually so that computations are performed. To set the Beam Area 
manually, either use the Set Beam Area selection under the Video window 
Options menu, or use the Set Beam Area drawing tool on the Video window 
toolbar. The Beam Area-Position/Size dialog box can also be used to define 
the top, left, width and height coordinates.  

4.1.6.3. Magnification Factor 
This item under the Data Collection menu opens a dialog box for entering 
an optical magnification factor. This is necessary to obtain accurate beam 
width values whenever optical components such as lenses or mirrors with 
magnification are used to image a laser beam. This factor is used to scale 
the linear pixel dimension of the camera selected for measurements. The 
default magnification factor is 1. (If you do not know the magnification factor 
of your optical system, it can be determined by mechanically translating an 
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object a known distance horizontally through the image. The measured 
translation of the object in the image divided by the known mechanical 
translation is the magnification factor.)  

4.1.6.4. Displaying Parameters. 
Computed parameters can be displayed in the Beam Statistics window or in 
the Time Statistics windows. The selection of parameters for display is 
accomplished through the Parameters entry under the Options menus for 
these windows. Selecting the Parameters entry opens a dialog box for 
specifying which parameters will be displayed. 

4.2. Advanced Use 
The previous Quick-Start procedure utilizes only the very basic features of 
the USBeamPro Acquisition and Analysis Software program. The program is 
very powerful and flexible, allowing users to configure the image data 
acquisition, the analyses, and the information display windows to suit their 
individual needs.  

The Data Collection menu includes selections that determine or affect the 
collection of data. Through the Data Analysis dialog, users select the types 
of data analyses that will be performed, all in accordance with the ISO 
Standards.  

Numerous parameters can be computed and displayed, determined in the 
Beam Statistics Parameters dialog. Parameters measured include: 

♦♦  Beam width 
♦♦  Centroid and peak location 
♦♦  Major and minor axes 
♦♦  Beam orientation 
♦♦  Ellipticity, eccentricity 
♦♦  Gaussian fit 
♦♦  Beam uniformity 
♦♦  Beam divergence 
♦♦  Pointing stability 
♦♦  M2, K-factor 

Three methods for computing beam widths; Dslit Denergy, or D4σ, are available 
in either XY or Elliptical analysis modes.  

Energy/Power Uniformity or Flat Top analyses can be performed on 
selected regions of interest.  

There are also three methods of computing Beam Divergence. 
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Windows available for display include the: 

♦♦  Video window;  
♦♦  Profile window; 
♦♦  2D Contour window; 
♦♦  3D Profile window;  
♦♦  Beam Statistics window;  
♦♦  Time Statistics window; 
♦♦  Pointing window;  
♦♦  K-Factor window.  

Each window has an Options menu that offers many choices in how data will 
be displayed. There is also a Notes window for entering text. Users can 
arrange and size multiple windows as required, and these screens can be 
saved as files for future use. Limit Analyses can be performed on selected 
beam parameters. Also, data can be exported to spreadsheets, math and 
statistical analysis programs, and process/ instrumentation programs by 
logging data to files or COM ports, or shared using ActiveX Automation. 

A complete description of the various features of the program is given in this 
section. Users are encouraged to learn the software features in detail and to 
experiment with the program. A little time spent in advance learning the 
features of the system will go a long way in making the USBeamPro 
Acquisition and Analysis System an invaluable resource for laser beam 
characterization. 

4.3. Operating Hints 
1. Use the manual to completely familiarize yourself with all the 

features of the USBeamPro Acquisition and Analysis 
Software. 

2. Use Laser Positioning mode for positioning the laser beam 
in the aperture, and also for course tuning of the laser beam. 
Only use Analysis mode when you need parameter values. 

3. Configure the Data Analysis and Beam Statistics 
Parameters only for values that are needed. For example, do 
not use Elliptical Analysis if the laser beam is nearly circular. 
Additional computations require more time and reduce the 
system performance in terms of data update rate and the 
cross hairs will be very unstable, constantly jumping around to 
find the “ellipse”. 

4. Calibrate the system periodically. Array sensors are very 
sensitive and can sense changes in background light intensity 
due to such things as reflections from a white shirt or light 
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from a computer monitor. For accurate and repeatable 
measurements, the consistency of the experimental setup is 
important. Therefore, calibrate the system whenever there is 
a change in setup or background lighting. This will ensure the 
most consistent and accurate results.  

5. Open only those windows that are required by your 
application. Additional windows reduce the data update rate. 
This is particularly true for the Video, 2D Contour, and 
3D Profile windows. If all you need is beam width values, and 
you require the fastest data update rate, close unnecessary 
windows, including the Video window, and use only the Beam 
Statistics and/or Time Statistics windows. 

6. Every window has a display update rate that is configured 
under the Options menu for each window. You may want to 
change the default Timing settings in order to improve the 
performance of your system. 

7. Use Autotracking if your beam is stable. If your beam is 
unstable, the Beam Area as defined by the Autotracking 
algorithm will also be unstable. This will adversely affect the 
Profile and 3D Profile windows, in that the displays will tend 
to change or pop with each change in the Beam Area. In this 
case, set a manual Beam Area to eliminate these effects. 

8. Use Frame Background Subtraction, because the 
USBeamPro CMOS chip has a shaded background. Frame 
Background Subtraction will also eliminate any stray light 
that is not due to the incident laser beam. 

9. If data is being collected over long periods of time, use the 
Automatic backup feature to prevent total loss of data in the 
event of a Windows General Protection Fault. 

4.4. Program Menus 

4.4.1. File Menu 
As in any other Windows compliant program, the File menu is used for file 
manipulation and printing.  

When File on the Menu Bar is clicked, the pull-down menu below appears. 
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New Closes all open windows, then creates a new 

Video window. 

Open… Opens the File Open dialog box. It lists Data 
Files from the current working directory. 

 To open a data file, select one from the list and 
then select the Open button. All windows will be 
closed and the new file will be loaded. The 
data, windows and computed statistics from the 
file will be displayed. 

 To open a configuration file, repeat the above 
steps except select Configuration Files from 
the Files of Type combo box. The list will show 
all configuration files in the current working 
directory. Configuration files contain everything 
that a data file does, except for the raw data 
and beam statistics. Use this to save a 
particular screen layout and set of data 
acquisition parameters without the raw and 
computed data. 

Close Closes all open windows and halts data 
collection.  

Save Saves the current data and windows 
configuration in the currently active file. The 
name of this file is displayed on the main 
window title bar. 
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Save As… Opens the File Save As dialog box. It lists Data 
Files from the current working directory. Either 
select an existing file from the list or enter a 
new name in the File Name edit box. To save 
as a data file, simply select the Save button. 
There are 5 different file types, identified by 
their extensions: 

 *.usd Data File: Includes screen configuration and 
associated image and computed data. Only the 
USBeamPro Acquisition and Analysis Software 
can use this file. 

 *.usc Configuration File: Includes screen configuration 
only. Only the USBeamPro Acquisition and 
Analysis Software can use this file. 

 *.prw Frame Data - Raw File: Includes raw image 
data only. The Frame Data File is a binary file. It 
contains the number of columns and rows, 
saved as unsigned short (16-bit unsigned), then 
each pixel of the frame as an unsigned char (8-
bit unsigned). This file cannot be read back by 
USBeamPro Acquisition and Analysis Software. 

*.tif Frame Data - TIFF File. Saves the current 
frame (raw image) as uncompressed 16-Bit 
TIFF image. 

 *.asc ASCII File. Saves data displayed in all open 
views in ASCII format. 

 IMAGE Saves the program screen as an IMAGE file, 
either BMP, JPEG, GIF, TIFF, or PNG File. 
This is used for exporting graphics into 
documents and reports. The IMAGE file format 
is selected under Image Settings dialog in the 
File menu Preferences item.  

Preferences 
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 Timed Backup Opens the Automatic Data Backup dialog 
box. If the Backup On checkbox is selected, 
then all data will be saved automatically at the 
specified interval. Use this feature when 
collecting data over extended periods to 
prevent data loss in the event of a power 
outage or other catastrophe. When the program 
is restarted after such an event, the backup file 
will load and data collection resumes from the 
point of the last automatic save. 

 
 On Power Up Opens a menu with the following 3 selections: 

 

 
 Load Previous 

Setup 
When checked, the last data file will 
automatically load at startup. 

 Global Collect 
On 

When checked, data collection resumes at 
startup. 

 Background 
Logo 

When checked, the Photon Logo appears as 
the background for the main window. 

 On Exit Opens a menu with the following selections: 

 
 Save Setup When checked, the Save As dialog box 

appears, prompting the user to save the latest 
data. 

 Prompt When checked, the user is prompted with an 
Leaving Already? dialog upon exit. 
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Image Settings… Opens a dialog box for selecting the image 
export format for the active window and the full 
screen. Available choices for Image Format 
are: 

 BMP Windows Bitmap 

 JPEG JPEG File Interchange Format (JFIF) 

 GIF Graphics Interchange Format 

 TIFF Tagged Image File Format 

 PNG Portable Network Graphics 

 This dialog is also used to set the image 
compression for JPEG Files. 

 
Print… Prints a picture of all open windows to the 

currently selected default printer. The user may 
change this printer from the Print dialog if 
desired. 

Print Setup… 
 

Opens a dialog box for selecting and 
configuring printers 

Exit Exits the program. 

4.4.2. Edit Menu 

When Edit on the Menu Bar is clicked, the pull-down menu below appears: 

 

 

Copy Copies the current window to the Windows 
clipboard as a bitmap image and/or text, 
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depending on the active view. From there, the 
information can be pasted into other program 
applications. 

Export… Opens the File Save As dialog box for 
exporting the active window as an image file, 
either BMP, JPEG, GIF, TIFF or PNG, used for 
exporting graphics into documents and reports. 
The image file format is selected under Image 
Settings dialog in the File menu, Preferences 
item. 

4.4.3. View Menu 

When View on the Menu Bar is clicked, the pull-down menu below appears: 

 

 
Main Toolbar When checked, the toolbar on the main window 

is visible. 

Local Toolbar When checked, the toolbar of the currently active 
view is visible, if available. 

Status Bar When checked, the status bar at the bottom of 
the main window is visible. 

4.4.4. Options Menu 
There are various options associated with each window. These are selected 
in the Options menu. When a particular window is selected or active, the 
various options associated with that window are listed in the Options menu. 
The list of options is unique for each window. The options list for each 
window can be found below, under the window descriptions.  
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4.4.5. Data Collection Menu 
The Data Collection menu includes selections that determine or affect the 
collection of data. When Data Collection on the Menu Bar is clicked, the 
pull-down menu below appears: 

 
Global Data Collection Enables data collection and updates for all 

windows. 

Auto Track Selects the autotracking feature, which 
automatically locates and tracks the laser beam 
and defines an optimal region, called the Beam 
Area, for performing data analysis. 

Acquisition Mode Opens a menu for selecting 1 of 4 acquisition 
modes.  

 
Choices are: 

 Laser Positioning Captures and displays images in the Video 
window. No calculations are performed, thus 
providing the fastest update rate. This mode is 
intended for setup prior to acquiring quantitative 
data. Use this mode for positioning your laser in 
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the sensor aperture, adjusting attenuation, or for 
visually tuning the laser. 

 Analysis Enables data analysis computations.  

 Single Shot Enables Single Shot profile acquisition. 

 Multiple 
Samples… 

Currently inactive. 

Trigger Mode Opens a menu for selecting 1 of 3 trigger modes. 

 
Choices are: 

 CW Captures and displays images continuously. Use 
this mode when measuring CW laser beams. 

 Pulsed Captures and displays good images continuously. 
Use this mode when measuring pulsed lasers 
where external triggering is not available. In this 
mode the software rejects invalid frames. 

 External Captures and displays images whenever an 
external trigger pulse is detected. Use this mode 
when measuring pulsed lasers where external 
triggering is available. In this mode the software 
rejects invalid frames. This is the best mode for 
your pulsed laser. 

Averaging… Opens a dialog box for setting the number of 
frames to average. Entire frames are sequentially 
added up to the set value and then divided by the 
number of frames to obtain an average frame. This 
is not a rolling average; therefore, setting this 
number higher will slow the update rate 
significantly. 

 



4.16  USBeamPro CCD Installation and Operation Manual 

B050909780-1.0  Photon Inc. 

Image Flip Opens a menu for selecting the orientation of the 
image with respect to Vertical and Horizontal. 
Select None to display the original frame, 
Horizontal to flip the image about the horizontal 
axis, Vertical to flip the image about the Vertical 
axis. This operation takes precedence over Image 
Rotation. 

 
Image Rotation Opens a menu for selecting rotation of the image. 

Select 0° to display the original frame, or 90°, 180°, 
270° to rotate the image in clockwise direction. 

 
Camera Selection… Opens the Camera Selection dialog for selecting 

USBeamPro cameras for use by Serial Number. 
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Camera Settings… Opens the Camera Settings dialog for setting the 
camera Exposure Time. The Exposure Time 
ranges from 50µs to 100ms. The selected 
Exposure Time is displayed in the edit box. The 
Exposure Time can be adjusted using either the 
Slider Control or the Edit box. Within the Edit box 
the value can be set using the Arrows, or typed in 
manually. (Note! Typed changes are automatically 
rounded to allowed values. Also, typed changes 
do not take effect until the focus changes from the 
Edit box, e.g. by “tabbing” out.) 

The default setting for exposure is 20ms. Use the 
Auto Settings button to perform a single 
automatic setting of the Exposure. 
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Calibration…  Opens the Calibration dialog for performing a 
background calibration of the camera. The info 
field displays the date and the time of the last 
calibration. If the camera was not calibrated the 
message “The system is not currently calibrated.” 
is displayed. 

To perform a calibration, simply follow the 
instructions in the dialog box. First, block the 
laser beam (as far from the camera aperture as 
possible). Then click on the Calibrate button. The 
calibration is complete when the OK button 
becomes active. The current date and time will be 
displayed in the info field. Then click on the OK 
button to exit the Calibration dialog.  

 

Background 
Correction 

Opens a menu for selecting the method of 
background correction. The available choices are: 

 

 Frame Selects the background frame correction method. 
The background frame values are subtracted 
from each data frame on a pixel-by-pixel basis. 
This is the default setting. 

 Mean Selects the background mean value correction 
method. The mean value of the background 
frame is subtracted from each pixel value in the 
data frame. 

None Selects no background correction. 
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Data Analysis Opens the Data Analysis dialog for selecting the 
calculations to be performed on each data frame. 

 
The various selection choices are: 

 ISO Profiles Selects the method of ISO Profiles beam width 
computation. Choose from 1 of 3 possible 
selections: 

  D slit Selects the slit method for determining beam 
widths. The computation simulates a scanning slit 
aperture with slit width equal to the effective pixel 
dimension of the camera used for measurement. 
Scans are performed along the horizontal and 
vertical directions or along the directions of the 
major and minor axes if elliptical analysis is 
selected. 

  D energy Selects the encircled energy method for 
determining beam widths. The computation 
simulates circular apertures centered at the laser 
beam centroid and calculates the energy through 
the aperture. The diameter of the circular 
aperture is increased until the specified energy 
percentage is obtained. 

  D 4sigma Selects the second moment method for 
determining beam widths. The computation 
determines the second moment of the laser beam 
distribution. 
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 Elliptical 
Analysis 

By default, data analysis is performed along the 
horizontal and vertical directions of the pixel 
array. If the Elliptical Analysis box is checked, 
the analysis will be performed along the 
directions of the major and minor axes of the 
beam. 

 Gaussian Fit:  To enable Gaussian fit calculations of the profiles 
displayed in the Profile window (either Slit or 
Pinhole scans), check the box labeled Gaussian 
Fit. The Gaussian fit to the profiles can then be 
displayed as overlays on the profiles in the 
Profile window by selecting the Fit option for that 
window. The corresponding Gaussian Goodness-
of-Fit parameter can be displayed in the Beam 
Statistics Parameters or the Time Statistics 
window.  

 Flat Top Analysis Enables Uniformity or Flat Top Analysis of 
Energy Region of Interest (ROI). The Energy ROI 
is a user-defined region in the Video window. 

  Threshold (%) Defines the threshold as a percentage of the 
peak pixel value for which the Flat Top Analysis 
will be performed. Only those pixels in the Energy 
ROI that are greater than this value are included 
in the analysis. 

 Energy When selected, the total energy or power in the 
Beam Area is computed. A reference energy or 
power value, (from independent measurements 
with an energy or power meter), and the 
appropriate units must be entered. In addition, the 
energy or power in the Energy ROI and the 
percentage of the energy in the Beam Area are 
computed in the Flat Top Analysis, if enabled. 
Also, the Min, Mean, and Max values in the Flat 
Top Analysis will be reported as Fluence or 
Irradiance per pixel. 

 Divergence Selects the method for divergence computation. 
Choose from 1 of 4 possible selections: 

  Off No divergence computations will be made 

  Lens Selects the Lens method for computing 
divergence. When selected, the lens focal length, 
in millimeters, and the beam width clip level 
percentage must be specified. 
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  Point Source Selects the Point Source method for computing 
divergence. When selected, the distance from the 
point source to the measurement plane, in 
millimeters, and the beam width clip level 
percentage must be specified. 

  Numerical 
Aperture 

Selects the Numerical Aperture method for 
computing divergence. When selected, the 
distance from the point source to the 
measurement plane, in millimeters, and the beam 
width clip level percentage must be specified. The 
numerical aperture equivalent of the divergence 
half-angle is reported (sin(θ/2)). 

Magnification 
Factor… 

Opens a dialog box for entering an optical 
magnification factor that will scale the camera pixel 
dimension. This is necessary to obtain accurate 
beam width values whenever optical components 
such as lenses or mirrors with magnification are 
used to image a laser beam. It allows 
compensation of any optical or imaging schemes 
that change the size of the beam image. This 
factor is used to scale the linear pixel dimension of 
the camera selected for measurements. The 
default magnification factor is 1. 

 
Angle Units Opens a menu for selecting the units need for 

reporting all the angles, either miliradians or 
degrees. 
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Recompute Click on Recompute to redo computations on the 
image data currently in memory. Use this feature 
if any changes to the analysis are desired, e.g., 
changing the method of beam width computation, 
or changing the Beam Area or the Energy ROI to 
analyze a different region of the image. 

Reset All Views Resets all open data-display windows. 

Settings Status… Opens the Status screen dialog, which displays 
the current program settings. 

 

4.4.6.  Window Menu 

When Window on the Menu Bar is clicked, the pull-down menu below appears.  
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The Window menu is used to open new windows, arrange windows and 
window icons and to close all open windows. The list at the bottom of the menu 
shows which windows are open with the currently active window checked. 

New Windows Opens a menu for selecting windows for viewing. 

 
Cascade Arranges the open windows in cascade format. 

Tile Arranges the open windows in tile format. 

Arrange Icons Arranges the minimized window as icons on the bottom 
of the main window. 

Close All Closes all open windows. 

Window List Displays a list of all open windows and displays a check 
before the currently active window name. 

4.4.7. Help Menu 

Use the Help menu to access Help Topics, and the About USBeamPro 
dialog box. Help Topics are currently unavailable. 
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4.5. Window Descriptions 

4.5.1. Profile 

 

The Profile window displays either Pinhole or equivalent Slit profiles in 
orthogonal directions along the crosshairs displayed in the live Video 
window. An example of the Profile window is given above. If data analysis is 
set to the default XY mode, then the profile axes are horizontal and vertical. If 
data analysis is set to Elliptical Analysis Mode, then the profile axes are 
oriented along the major and minor axes of the laser beam image. 

The locations of the Pinhole profiles are identified by the crosshairs in the 
Video window. The pinhole profile locations can be selected to be through 
either the beam centroid, the peak pixel, or through user selected points by 
dragging the crosshairs with the mouse to the desired location. Also, when in 
elliptical analysis mode, the orientation of the axes can be changed arbitrarily 
by holding down the control key and using the mouse to rotate the axes. 

For Slit profiles the crosshairs identify the direction of the equivalent slit scan.  
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The Options menu available when the Profile window is active is shown 
below. 

 
The selections are: 

Data Collection Turns data collection on/off. 

Timing… Opens a dialog box for selection of the profile 
update rate. 

 
Fit Places a blue-colored Gaussian fit overlay on the 

profiles if Gaussian Fit 1D is enabled in the Data 
Analysis dialog box. 

Normalize Scales the profile amplitude to have a peak value 
of 1, i.e. full scale. 

Profile Selects either the Pinhole or the Slit profiles for 
display. 

 
Scale Allows the user to choose between a Linear and 

a Logarithmic scale. 

 
 



4.26  USBeamPro CCD Installation and Operation Manual 

B050909780-1.0  Photon Inc. 

These options can also be selected using the Profile window toolbar: 

 

 Starts data collection. 

 Stops data collection. 

  Turns Gaussian Fit overlay on/off. 

 Turns Normalization on/off. 

4.5.2. Video 
The Video window displays the video laser image. An example of the Video 
window is given below. 
The crosshairs in the image identify the location and/or direction of profiles 
displayed in the Profile window, depending on the type of profile selected, 
either Pinhole or Slit, in the Profile options. If data analysis is set to the 
default XY mode, then the profile axes are horizontal and vertical. If data 
analysis is set to elliptical mode, then the profile axes are oriented along the 
major and minor axes of the laser beam image. 
For Pinhole profiles the pinhole profile locations can be selected to be 
through either the beam centroid, the peak pixel, or through user selected 
points by dragging the crosshairs with the mouse to the desired location. 
Also, when in elliptical analysis mode, the orientation of the axes can be 
changed arbitrarily by holding down the control key and using the mouse to 
rotate the axes. 
For Slit profiles the crosshairs identify the direction of equivalent slit profiles. 
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The Options menu available when the Video window is active is also shown 
below. 

 

The selections are: 

Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate. 

 
Select Colors… Opens a dialog box for selection of the display 

color scheme. Choices available are: Rainbow, 
Gray, Red, Green and Blue. 
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View Finder Opens a display box that shows the entire 
camera video image (1280 × 1024 pixels). 

 
Zoom Factor Opens a menu for selecting the zoom factor. 

Choices available are: 1:2×, 1×, 2×, 4×, 8×, 16×, 
and Fit to Window proportional to the camera 
array dimension of 1280 × 1024 pixels. 

 
Auto Position When auto position is selected the laser beam 

image will automatically be positioned in the 
displayed portion of the Video window. 

Overlays Opens a menu for selecting which overlays will be 
displayed in the Video window. Choices available are: 

 
 Cross Hairs Selecting Cross Hairs opens a second menu with 

the following choices: 

 
The selection is available only if the Pinhole is 
selected under the Profile option in the Profile 
Window. When the Profile display is set to Slit, the 
Cross Hairs are drawn through the centroid and 
cannot be moved, so no other selections can be 
made. 
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  Off Turns the cross hair overlay off or on. 

  Centroid Places the cross hairs at the centroid. 

  Peak Places the cross hairs at the peak. 

  User Defined Allows the cross hairs to be positioned manually 
at an arbitrary position using the mouse. 

 Beam Area Turns the Beam Area overlay off or on. 

 Energy ROI Turns the Energy ROI overlay off or on if Flat Top 
Analysis is enabled. 

Set Beam Area  Allows the user to set a Beam Area manually. 

The beam area can be defined/adjusted using the 
mouse or defining the top, left, width and height 
coordinates.  

 To set Beam Area 
using the mouse: 

First click on Set Beam Area. Next, use the 
mouse to draw and/or adjust the desired beam 
area in the Video window. Finally, click on Set 
Beam Area a second time to validate the Beam 
Area previously drawn. In drawing/adjusting mode, 
depress ESC to discard all the changes and revert 
Beam Area to its original size and position. 

Note: Selecting the Set Beam Area will also open 
(or close) the Beam Area–Position/Size dialog 
box. 

 To set Beam Area 
using coordinates: 

In the Beam Area–Position/Size dialog box, 
enter the Top, Left, Width and Height coordinates 
in the designated edit boxes.  

 
  Redraw Redraws the beam area based on the new 

coordinates and keep the Beam Area-
Position/Size dialog box open. 

  Close Closes the dialog box. 

  Cancel Ignores any changes made during the 
drawing/adjusting mode, reverts Beam Area to its 
original size and position and closes the dialog box. 
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Set Energy ROI  Allows the user to set the Energy ROI manually. 
The ROI can only be drawn inside the Beam Area. 
The ROI can be defined/adjusted using the mouse 
or defining its coordinates.  

 
Note: Flat Top Analysis must be enabled for the 
Energy ROIs to be available. 

 To set Energy ROI 
using the mouse: 

First click on Set Energy ROI; this opens a 
second menu with the following selection choices. 
Rectangle, Square, Elliptic, and Circle. Click on 
one of these to determine the general shape of the 
Energy ROI to be drawn. Next, use the mouse to 
draw and/or adjust the desired Energy ROI in the 
Video window. Finally, click on the shape selection 
a second time to validate the Energy ROI 
previously drawn. In drawing / adjusting mode, 
depress ESC to discard all the changes and revert 
Energy ROI to its original size and position. 

Note: Selecting the one of the Set Energy ROI 
item will also open (or close) the corresponding 
Energy ROI – Position/Size dialog box. 

To set Energy ROI using coordinates: 

 Rectangle: Enter the Left, Top, Width and Height 
coordinates for the Rectangle Energy ROI. 
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 Square: Enter the Left, Top coordinates and the Size for 
the Square Energy ROI. 

 
 Elliptic: Enter the Left, Top coordinates and the 

Horizontal Axis and Vertical Axis for the 
Elliptical Energy ROI. 

 
 Circle: Enter the Left, Top coordinates and the Diameter 

of the Circle Energy ROI. 

 
  Redraw  Redraws the beam area based on the new 

coordinates and keep the Energy ROI-Position/ 
Size dialog box open. 

  Close Closes the dialog box. 

  Cancel Ignores any changes made during the 
drawing/adjusting mode, reverts Energy ROI to its 
original size and position and closes the dialog 
box. 
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The Beam Area and Energy ROI drawing functions can also be accessed on 
the Video window toolbar: (Note: The ROI drawing tools are only available if 
Flat Top Analysis is enabled.) 

 

 Set Beam Area drawing tool. 

 Energy ROI: Elliptical region drawing tool 

 Energy ROI: Circular region drawing tool 

 Energy ROI: Rectangular region drawing tool 

 Energy ROI: Square region drawing tool 

4.5.3. 3D Profile 

The 3D Profile window displays the laser beam image in a ‘3-dimensional’ 
viewing format. The laser beam image can be rendered with either a 
wireframe or solid surface, with user selected clip levels and colors.  
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The Options menu available when the 3D Profile window is active is shown 
below. 

  
The selections are: 

Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate. 

 
Clip Level… Opens a dialog for selecting clip level contours 

and their colors. 

 
This option is not available for data displayed 
using the logarithmic scale. In this case, the 
contour levels are fixed at the 0, -3, -5, -10, -13, 
-20, -23, -30, and the -33 dB levels. 



4.34  USBeamPro CCD Installation and Operation Manual 

B050909780-1.0  Photon Inc. 

Clip Legend When selected, the Clip Level legend will be 
displayed in the view. 

Fill Contours When selected, the different clip levels on the 
beam will be clearly delineated. Please be aware 
that this option will slow the acquisition rate of 
the system. 

Solid Surface When selected, the image will have a solid 
surface. When not selected, the image will be 
rendered as a wireframe. 

Resolution Opens a menu for selecting the resolution of the 
3D display. Choices are: High, Medium, Low. 
Data update rate is reduced and image  
manipulation is slower as resolution is increased. 

 
Scale Allows the user to choose between a Linear and 

a Logarithmic scale. 

 

The toolbar at the right border of the window contains 8 buttons used to 
select several viewing and image manipulation features. These buttons are, 
from top to bottom: 

 
Chooses the Arrow cursor, which allows image 
manipulation only using the mouse and the 
thumbwheel controls. 

 
Chooses the Hand cursor, which allows image 
manipulation using the mouse directly in the 
image or by using the thumbwheel controls. 
(When the mouse is moved to the window 
border the Hand cursor changes to the Arrow 
cursor). 

 
This Help menu is inactive. 

 
Resets the view to a preset Home default 
position, size and orientation. 

 
Sets the default settings for the Home button. 

 
Restores the view to include the entire image. 
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Activates the Seek cursor. After positioning this 
cursor on a selected point in the image and 
clicking the left mouse button, a close-up zoom 
to that point will be performed automatically. 
Also, the center of rotation will be set to that 
point. 

 ,   
Toggles between the Perspective and 
Orthographic projection modes. 

 
There are also three thumbwheels along the 
window border, designated Dolly, Rotx, and 
Roty, which are used to zoom and rotate the 2D 
image. 

The image can be rotated, translated, panned, and zoomed using the mouse 
with the Arrow cursor and the thumbwheel control knobs or using the mouse 
with the Hand cursor, as described below. 

Rotation Rotate the image using the mouse and the 
Arrow cursor with the thumbwheels labeled 
Rotx and Roty. Alternatively, use the mouse 
and the Hand cursor to directly rotate the 
image; Position the hand cursor over the image, 
depress the left mouse button, and drag the 
mouse to obtain the desired orientation. 

Pan/Translate While depressing the control key <CTRL>, use 
the mouse and the Hand cursor to directly pan 
the image. Position the hand cursor over the 
image, depress the left mouse button, depress 
the control key, and drag the mouse to move 
the image to the desired location. 

Zoom The method for zooming the image depends on 
the type of display projection selected. In the 
Perspective projection mode, use either the 
zoom control scroll bar at the bottom of the 
window, or use the Dolly thumbwheel at the 
lower right border of the window. In the 
Orthographic projection mode, use the Zoom 
thumbwheel at the lower right border of the 
window. You can also zoom by using the 
mouse. To zoom in (out) hold the Ctrl+Shift keys 
down and drag the mouse toward (away from) 
the center while holding the left mouse button. 
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4.5.4. 2D Contour 
The 2D Contour window displays the laser beam image with user specified 
contour overlays. An example of the 2D Contour window is shown below. 

 
The Options menu available when the 2D Contour window is active is 
shown below. 
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The selections are: 

Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate. 

 
Clip Level… Opens a dialog for selecting clip level contours 

and their colors. 

 
This option is not available for data displayed 
using the logarithmic scale. In this case, the 
contour levels are fixed at the 0, -3, -5, -10, -13, 
-20, -23, -30, and the -33 dB levels. 

Clip Legend When selected, the Clip Level legend will be 
displayed in the view. 

Fill Contours When selected, the different clip levels on the 
beam will be clearly delineated. Please be aware 
that this option will slow the acquisition rate of 
the system. 

Solid Surface When selected, the image will have a solid 
surface. When not selected, the image will be 
rendered as a wireframe. 
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Resolution Opens a menu for selecting the resolution of the 
3D display. Choices are: High, Medium, Low. 
Data update rate is reduced and image 
manipulation is slower as resolution is increased. 

 
Scale Allows the user to choose between a Linear and 

a Logarithmic scale. 

 
The toolbar at the right border of the window contains 8 buttons used to 
select several viewing and image manipulation features. These buttons are, 
from top to bottom: 

 
Chooses the Arrow cursor, which allows image 
manipulation only using the mouse and the 
thumbwheel controls. 

 
Chooses the Hand cursor, which allows image 
manipulation using the mouse directly in the 
image or by using the thumbwheel controls. 
(When the mouse is moved to the window border 
the Hand cursor changes to the Arrow cursor). 

 
This Help menu is inactive. 

 
Resets the view to a preset Home default 
position, size and orientation. 

 
Sets the default settings for the Home button. 

 
Restores the view to include the entire image. 

 
Activates the Seek cursor. After positioning this 
cursor on a selected point in the image and 
clicking the left mouse button, a close-up zoom 
to that point will be performed automatically. 
Also, the center of rotation will be set to that 
point. 

 ,   
Toggles between the Perspective and 
Orthographic projection modes. 

 

There are also three thumbwheels along the 
window border, designated Dolly, Rotx, and 
Roty, which are used to zoom and rotate the 
image. 
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The image can be rotated, translated, panned, and zoomed using the mouse 
with the Arrow cursor and the thumbwheel control knobs or using the mouse 
with the Hand cursor, as described below. 

Rotation Rotate the image using the mouse and the 
Arrow cursor with the thumbwheels labeled 
Rotx and Roty. Alternatively, use the mouse and 
the Hand cursor to directly rotate the image; 
Position the hand cursor over the image, 
depress the left mouse button, and drag the 
mouse to obtain the desired orientation. 

Pan/Translate While depressing the control key <CTRL>, use 
the mouse and the Hand cursor to directly pan 
the image. Position the hand cursor over the 
image, depress the left mouse button, depress 
the control key, and drag the mouse to move the 
image to the desired location. 

Zoom The method for zooming the image depends on 
the type of display projection selected. In the 
Perspective projection mode, use either the 
zoom control scroll bar at the bottom of the 
window, or use the Dolly thumbwheel at the 
lower right border of the window. In the 
Orthographic projection mode, use the Zoom 
thumbwheel at the lower right border of the 
window. You can also zoom by using the mouse. 
To zoom in or out hold the Ctrl + Shift keys down 
and drag the mouse toward (away from) the 
center while holding the left mouse button. 
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4.5.5. Beam Statistics 

The Beam Statistics window, as shown below, displays a tabular summary 
of beam parameters and statistics. Any or all of the computed beam 
parameters set up in the Data Analysis dialog may be viewed in this way. It 
is also used for Limit Analysis. The parameters for viewing are selected in the 
Beam Statistics Parameters dialog box. 

 

Limit Analysis 

Limit analysis can be performed on any of the parameters reported in the 
Beam Statistics window. The parameters are checked against user 
specified maximum and/or minimum values and the result of the analysis is 
displayed using icons in the Beam Statistics window, as shown above. To 
configure the analysis, either double click with the left mouse button on the 
desired parameter, or, alternatively, use the Up/Down Arrow keys to 
highlight the parameter and then press the Space key. This will open the 
following dialog box for setting the parameter limits for the analysis. 
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Either one or both limits can be set. The icons for reporting the analysis are: 

 Parameter value is within the set limit or limits. 

 Parameter value is greater than the maximum 
limit. 

 Parameter value is less than the minimum limit. 

The Options menu available when the Beam Statistics window is active 
offers the following selections: 

 

 

Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate. 

 

Reset Resets the Beam Statistics table. 

Parameters… Opens the Beam Statistics Parameters dialog, 
shown below, for selecting the parameters to be 
listed in the Beam Statistics table. Parameters 
available for selection are determined by the 
selections made in the Data Analysis dialog. 
Those parameters that are unavailable for display 
are grayed out in the dialog box. This dialog is also 
used to select which statistical quantities to list in 
the table for each parameter selected and how the 
statistics will be calculated. All the parameters are 
computed in accordance with ISO Standards. In 
addition, the setup for data logging to files or serial 
communication ports is made here. 
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Selection options in the Beam Statistics Parameters dialog box are listed below. 

  

Note: If a selection is not available or grayed out in this box, that option must 
first be turned on in the Data Analysis dialog box. In order to do this, go to 
Data Collection, select Data Analysis and then mark the appropriate 
selection. 

Beam Width  

  13.5% (86.5% encircled energy), horizontal and vertical 
or major and minor axes. 

  36.8% (63.2% encircled energy), horizontal and vertical 
or major and minor axes. 

  50.0% (50.0% encircled energy), horizontal and vertical 
or major and minor axes. 

  60.7% (39.3% encircled energy), horizontal and vertical 
or major and minor axes. 

  User % User Specified Value, horizontal and vertical or 
major and minor axes. 

 Elliptical Analysis  

  Rotation Angle of the major axis with respect to horizontal 
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  Ellipticity Ellipticity Factor 
  Eccentricity Eccentricity Factor 
 Flat Top Analysis  

  Min Minimum value in the Energy ROI 
  Max Maximum value in the Energy ROI 
  Mean Mean value in the Energy ROI 
  Flatness Flatness Factor 
  Uniformity Uniformity Factor 
  Energy % The percentage of Beam Area total energy or 

power in the Energy ROI. 
  Energy in ROI The energy or power in the Energy ROI 
 Centroid Location of the beam centroid reported in 

microns (µm) from the upper left corner of the 
image in the Beam Area. 

 Peak Location of the peak of the image in the Beam 
Area. 

 Irradiance The value of the irradiance at the peak location. 

 Total Energy The value of the total energy or power in the 
Beam Area. 

 Divergence Beam Divergence angle 

 Gaussian Fit Gaussian Goodness-of-Fit Value 

 Pointing  

  Position The beam area Centroid from the Pointing 
window. 

  Angle The pointing angle from the Pointing window. 
  Radius Distance from the reference position in the 

Pointing window. 
 Statistics  

  Continuous Selects a continuous average of data samples. 
  Rolling Selects a rolling average with user-specified 

number of samples. 
  Finite Selects a finite average with user-specified 

number of samples. 
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 Display  

  Value Selects display of the present value of the beam 
parameter. 

  Mean Selects display of the mean value of the beam 
parameter. 

  Min Selects display of the minimum value of the 
beam parameter. 

  Max Selects display of the maximum value of the 
beam parameter. 

  Std Dev Selects display of the standard deviation of the 
beam parameter. 

  Min Limit Selects display of the minimum limit value of the 
beam parameter set in Limit Analysis. 

  Max Limit Selects display of the maximum limit value of the 
beam parameter set in Limit Analysis. 

 Logging  

  Output  
   None No data logging. 

   File Data logging to specified file. 

    Opens a Save As dialog box for selecting the 
path and file name for the log file. After you click 
OK the full path and file name will be displayed 
in the File edit box. 

   Port Data logging to serial port COM1 or COM2. 

  Delimiter Selects the delimiter format for the logged data. 
   Date If selected, the date is attached to the logged file. 

   Time If selected, the time is attached to the logged file. 

   Serial 
Number 

If selected, the specified serial number is 
attached to the logged file. 

Font… Opens a dialog box for selecting the type and 
size. 

Log If data logging is enabled, one additional set of 
data is acquired and then displayed and/or 
logged to the file. If data collection is disabled for 
the Beam Statistics window, it allows the user to 
take individual data one set at a time and log into 
a file. The Hot Key ‘Ctrl+L’ enables logging even if 
another window is active as long as the Beam 
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Statistics is open. 

Some options can also be selected from the Beam Statistics window 
toolbar: 

 

   Starts data collection 

 Stops data collection 

 Resets  table 

 Opens Beam Statistics Parameters dialog 

4.5.6. Time Statistics 

The Time Statistics windows display strip charts of beam parameters versus 
time. Any or all computed beam parameters may be viewed in this way. Up to 
15 Time Statistics windows can be opened. Several overlays are available 
in the Options menu, including grids, statistical markers, and numerical 
statistical summaries. 
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The Options menu available when the Time Statistics windows are active 
offer the following selections: 

 

 
Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate and for how long data will be 
acquired in the active chart. If Manual is 
checked, one set of data points will be acquired 
each time the user selects Data Collection. 

 
Reset Graph Resets the active Time Statistics window. (A 

message prompt warns the user that old data will 
be lost). 

Grid On When selected, a grid overlay is displayed on the 
Time Statistics graph. 

Mean When selected, an overlay plot of the mean 
value is displayed. 

Min/Max When selected, overlay plots of the minimum 
and maximum values are displayed. 
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Standard Deviation When selected, an overlay plot of the standard 
deviation is displayed. 

Show Calculations When selected, the numerical values of the 
mean, minimum, maximum, and standard 
deviation values are displayed beneath the plot 
area. 

Font… Opens a dialog box for selecting the font type 
and size. 

Parameters… Opens the Parameters dialog box for selecting 
parameters to be plotted in the active Time 
Statistics window. 

 
 The choice of parameters are limited to those 

which are presently being computed, as set up in 
the Data Analysis dialog accessed in the Data 
Collection menu. These are the same 
parameters available to the Beam Statistics 
window. In addition to selecting the parameters 
to be plotted, this dialog is used to set the color 
of the plotted lines. 

Axes… Opens a dialog box for selection of manual or 
automatic configuration of the axes in the Time 
Statistics display. 
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Some of the options can be selected using the Time Statistics window 
toolbar: 

 

 
Starts data collection 

 
Stops data collection 

 
Resets  table 

 
Grid overlay on/off 

 Statistical calculations overlay on/off 

  
Opens Beam Statistics Parameters dialog 

 
Opens the Time Stat Axes dialog 

4.5.7. Pointing 
The Pointing window displays a screen that shows and tracks the location of 
the beam centroid with a colored dot or cross. An example is shown below. 
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It also displays a table showing the relative current position and the relative 
maximum position in the horizontal, vertical, and radial directions, and the 
corresponding angular displacement. Clicking on the colored box in the 
window opens a color selection dialog for choosing the color of the beam dot 
or cross indicator. A zoom control allows the user to scale the aperture of the 
pointing screen. 

The Options menu available when the Pointing window is active is shown 
below. 

 

 

The selections are:  

Data Collection Turns data collection on and off. 

Timing… Opens a dialog box for selection of the display 
update rate and for how long the window will 
update. 

 
Centroid Cross Selects the cross indicator for the centroid. If not 

selected the indicator is a dot. 

Accumulate Turns on the Accumulate mode, which displays 
centroid values for all subsequent data on the 
same plot, allowing observation of beam 
movement. 
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Parameter Averages… Opens a dialog for setting the number of points 
to be used in a moving average of the centered 
value. 

 

Default 
 

 Load Opens a dialog for loading a previously saved 
pointing screen setup. 

 Save Opens a dialog for saving a pointing screen 
setup. 

4.5.8. Notes 
The Notes window is used for entering user information. When active, a 
cursor appears in the Notes window. Use the keyboard to enter text, and the 
arrow keys to navigate. There are no options available for the Notes window. 
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4.5.9. K-Factor (M2 Wizard) 
The K-Factor Wizard window is an interactive program for determining the 
K-factor by the Rayleigh Method. The K-Factor Wizard window is a series of 
dialog boxes that prompt and guide the user through a series of 
measurements and data entries required for calculating the K-factor and M2. 
The calculated values are displayed in the final dialog box.  

 
Setup the laser and sensor so that you can easily move the sensor along the 
Z-axis (nearer or farther from the laser). Then start the K-Factor wizard. 
Follow the instructions that appear. Upon completing each step, select the 
Next button to continue. If you make a mistake select the Previous button 
and redo that step. When you have completed all of the steps, the wizard will 
display the results. It’s that easy! 

For more information, please read Application Note 230 available from your 
Photon Inc. representative or the Photon website, www.photon-inc.com. 

The formula is: 

2
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π
λ   or  
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M 12 =  
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where: 

λ wavelength in nm 

rZ2  minmax ZZ −  - Rayleigh range 

minD  Beam diameter in the beam waist 

maxZ  Distance along Z axis where beam diameter is minD×414.1  
(distal to test lens or laser) 

minZ  Distance along Z axis on the other side of the waist where 
beam diameter is minD×414.1  (proximal to test lens or laser) 

4.5.9.1. Measuring the K-Factor 
The K-Factor is a propagation constant for a laser source defined in the ISO 
standard as 

 

 

Physically, M can be thought of as a factor times the diffraction limit. For 
example, if one calculates the diffraction limit for a particular lens, the source 
with an 2.1=M  will produce a spot width 1.2 times the theoretical calculated 
value. 

The ISO standard requires 10 beam measurements and a curve-fitting 
algorithm. A faster method, called the Rayleigh method, provides accurate 
result with only 3 measurements. 

The Rayleigh Method can easily be derived from the definitions and gives 
fast, highly accurate and repeatable K-Factor values. This method requires 
you to measure twice the Rayleigh length for a source. A long focal length 
lens (high F# ≥20) should be used. You also need the wavelength and the 
minimum observed beam width, minD , while sweeping through the beam 
waist. 

4.5.9.2. Lens Selection and the Expected Rayleigh Length 
How does one select a focusing lens? How does one determine the Rayleigh 
distance for a source and a lens? 

We have found that the distance along the beam axis can be measured to 
the nearest 1/2mm if one selects a focused beam size from 80mm to 200mm 
(1/e2) beam width.  
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Example: 

Source nearly collimated wavelength 0.7µm and approximate exit beam 
width is 500µm (1/e2). 

The divergence for a diffraction limited source ( )1== KM  will be: 

rad0018.0
μm500
μm7.04;4

=
×
×

=
×
×

=
π

θ
π

λθ
D

; 

We can select the lens by assuming: 

θ×= fd  

or, if we want the predicted waist diameter d near the focal plane to be 
125µm, the required focal length is: 

69mm or μm444,69
0018.0
μm125

==f  

Let’s use a 75mm lens, which is more commonly found in a laboratory. The 
expected spot size is: 

μm1350018.0μm000,75 =×=×= θfd  

The expected Rayleigh length in the region of the waist will be: 

λ
π 2

4
dZ ×=  

where, d is the above 135µm calculated spot width. 

20.4mm or μm448,20
μm0.7

μm1357854.0 2

=
×

=Z  

mm8.40 or μm40,8962 =Z  

Thus we have a rough starting point for K-Factor measurements. If the 
K-Factor is much less than 1.0, the spot size will be larger than calculated 
and the Rayleigh length will be less than calculated. What is important is that 
by using the diffraction limited case one has a starting point. We suggest that 
one try this method with a small visible HeNe laser which is nearly always 
close to 1=K  to gain an appreciation for the method before trying an 
unknown source. If you get close to one with the HeNe source, you will have 
the measurement method understood! If you get 0.1>K , recheck alignment 
and go through the waist slowly enough to allow the software time to select 
the correct minimum waist. 
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4.5.9.3. Alignment  
To measure K-Factor, the user should position the sensor in the beam waist. 
Setup the laser and the sensor so the sensor can easily move along the 
Z-axis. This alignment is extremely important for getting accurate results!  

Alignment of the sensor and laser beam without the focusing lens: 
Before inserting the lens into the path, align the sensor axial travel motion 
parallel to the axis of the laser. We suggest that the non-alignment be no 
more than a couple of beam widths. For the example laser above, this would 
be ±500 microns. The Pointing window can be used to measure the 
misalignment over the Rayleigh range. 

For the example source (previous section) this means one should see no 
more than ±500µm motion either X or Y as one translates the sensor along 
the beam axis through a distance of 2Z (or 41mm for our example). 

Note! Move slowly through the waist region so the software can keep up with 
the measurement process.  

4.5.9.4. Insert the lens 
Once the sensor and source are aligned, insert and center the lens into the 
beam path. Now translate the sensor through the 2Z length and again try to 
keep the cross translation to less than ±1-2 beam widths. For the example 
beam, use the calculated 135µm as a goal. 

Be sure the lens is well centered or you will be measuring the lens aberration 
as well as the K-Factor for the source. With a visible source, one can usually 
observe a back reflection from both lens surfaces. Place the back-reflected 
beams just slightly to the side of the laser exit aperture. Sending the 
reflections back into the source may cause laser oscillations due to 
interference.  

Another centering approach is to use a machined centered removable 
aperture stop just before the lens. This could fit into the lens mount during 
alignment and be removed before measurements. Direct the beam through 
this small aperture (our source example uses a 2mm hole) during alignment. 
Be sure to remove the stop once aligned to prevent truncation of the source 
and consequently errors in measured K-Factors. 

Now you are ready to use the K-Factor Wizard. 
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4.5.9.5. Rayleigh Test Fixture Accessory 
Photon offers an accessory, a Rayleigh Test Fixture, which consists of a base 
plate, a slide that allows manual sensor axial [Z] translation and an LCD 
measurement ruler. The base plate is rigidly mounted to an optical table or 
rail. The translation distance readout is a Mitutoyo LCD ruler that spans 
150mm of travel and gives position values to the nearest 25µm. The total 
150mm travel allows the Rayleigh range to be such that a beam waist of 
approximately 200µm can be measured.  

The Mitutoyo scale can be zeroed at the first Rayleigh location, translated to 
the second to find a single direct read number in mm units to be inserted into 
the Wizard software. This accessory’s purpose is to make measurements of 
the Rayleigh range very easy and very repeatable. The user provides a 
source, a focusing lens and mount. 

4.5.9.6. Dual Axis Measurements with Astigmatism 
To measure K-Factor when the source is astigmatic, the user will need to 
modify the basic procedure slightly. Figure 4.2 shows what this looks like.  

 

 

Figure 4.2. Measurement on Astigmatic Source Using the K-Factor Wizard 
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Example Using the Rayleigh Test Fixture Accessory: 
1. Move the sensor to D Target for Aperture 1. Reset the Mitutoyo 

scale. Enter 0 for Z Position 1 under the Aperture 1 heading. 

2. Move the sensor to D Target for Aperture 2. Enter 10 for Z Position 1 
under the Aperture 2 heading. Select the Next button. 

3. Move slowly through the waist for Aperture 1 and verify the minD  is 
correct. 

4. Move slowly through the waist for Aperture 2 and verify the minD  is 
correct. 

5. Move the sensor to D Target for Aperture 1. Enter 24 for Z Position 2 
under the Aperture 1 heading. 

6. Move the sensor to D Target for Aperture 2. Enter 30 for Z Position 2 
under the Aperture 2 heading. Select the Next button. 

4.6. Toolbars 
Toolbars are provided to speed access to some of the most commonly used 
operations and features of the USBeamPro Acquisition and Analysis 
Software. Instead of accessing these features through the pulldown menus, 
simply click on the appropriate icon buttons on the toolbars. The operations 
and features include: opening windows, turning data collection on and off, 
selecting the acquisition mode, turning Autotracking on and off, and 
selecting options. In addition, some file handling operations such as opening 
and saving files, opening new files and printing can be initiated in this way. 
General program features are accessed on the main toolbar, while option 
features for the Video window, Profile window, Beam Statistics window, 
and Time Statistics window are accessed on window toolbars. The toolbars 
and descriptions of their icon buttons and functions are given below.  

For user convenience and preference, toolbars can be placed at different 
screen locations by dragging and dropping. 
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4.6.1. The Main Toolbar 

 

 
Opens a new file 

 
Opens the Open file dialog 

 
Saves the current file 

 
Opens the Print dialog 

 
Opens specific Help topics (currently inactive) 

 
Turns Autotracking on/off 

 
Turns Global Data Collection on/off 

     
Opens the Calibration dialog (also indicates the 
calibration status) 

 
Sets system to Laser Positioning mode 

 
Sets system to Analysis mode 

 
Sets system to Single Shot mode (currently 
inactive) 

 
Opens the Profile window 

 
Opens the Video window 

 
Opens the 3D Profile window. Up to 5 2D and 
3D windows combined can be opened. 

 
Opens the 2D Contour window 

 
Opens the Beam Statistics window 
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Opens the Time Statistics windows. Up to 15 
windows can be opened simultaneously. 

 
Opens the Pointing window 

 
Opens the K-Factor window 

 
Opens the Notes window. 

4.6.2. The Video Window Toolbar 

 

 Set Beam Area drawing tool 

 Energy ROI: Elliptical region drawing tool 

 Energy ROI: Circular region drawing tool 

 Energy ROI: Rectangular region drawing tool 

 Energy ROI: Square region drawing tool 

4.6.3. The Profile Window Toolbar 

 

 Starts data collection 

 Stops data collection 

 Gaussian Fit overlay on/off 

 Turns Normalization on/off 
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4.6.4. The Beam Statistics Window Toolbar 

 

 Starts data collection 

 Stops data collection 

 Resets  table 

 Opens Beam Statistics Parameters dialog 

4.6.5. The Time Statistics Window Toolbar 

 

 Starts data collection 

 Stops data collection 

 Reset table 

 Grid overlay on/off 

 Statistical calculations overlay on/off 

 OpensBeam Statistics Parameters dialog 

 Opens Time Stat Axes dialog 

4.7. Status Bar 
The status bar at the bottom of the screen displays the Trigger Mode, cursor 
location and the Beam Area information. The first pane displays the trigger 
mode: CW, Ext or Pulsed. The second pane displays intensity in counts at 
the mouse cursor location (when is pointing over the Live Window), given by 
position coordinates in microns, from the upper left corner. The third pane 
displays the position coordinates of the upper left corner in the Beam Area 
(BA) and the dimensions in microns of the Beam Area. The fourth pane 
displays the update rate in frames/second while global data collection is 
turned on. The last pane displays information about the calibration status. 
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4.8. ActiveX Automation 

USBeamPro Acquisition and Analysis Software provides a Microsoft 
Automation interface. As an automation server, USBeamPro Acquisition and 
Analysis Software exposes a set of methods and properties. Using ActiveX 
compatible programs such as LabVIEW or Microsoft Excel, a user can create 
his own Automation controller, which can display and process data from 
USBeamPro Acquisition and Analysis Software.  

The type library “USBeamPro.tlb” file in the Automation folder where the 
software has been installed contains a full description of the ActiveX 
interface. You can open and view this file with an OLE/COM viewer program. 

The properties and methods that USBeamPro Analysis Software exports are 
explained below. 

4.8.1. AcquisitionMode 
Property Type:  
VT_I2 - acquisition mode 
Remarks: 
Gets or sets acquisition mode. 
Possible values are defined in the type library file by the 
SelectionAcquisitrionMode enumeration: 

Acquisition Mode Selection Value Comments 
SEL_ACQMODE_ANALYSIS 0 Analysis Acquisition Mode 
SEL_ACQMODE_LASERPOS 1 Laser Positioning Acquisition Mode 
SEL_ACQMODE_SINGLESHOT 2 Not available 

4.8.2. TriggerMode 
Property Type:  
VT_I2 - trigger mode 
Remarks: 
Gets or sets trigger mode. 
Possible values are defined in the type library file by the 
SelectionTriggerMode enumeration: 

Trigger Mode Selection Value Comments 
SEL_TRIGGER_CW 0 Trigger Mode – CW 
SEL_TRIGGER_PULSED 1 Trigger Mode - Pulsed 
SEL_TRIGGER_EXT 2 Trigger Mode - External 
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4.8.3. AcquisitionResolution (deprecated) 
Property Type:  
VT_I2 - acquisition resolution 
Remarks: 
This property has been deprecated. When read and if set, it will remain 
SEL_RESOLUTION_1X. It has been left in to preserve the ordinal numbering 
of the remaining properties and methods. 
Gets or sets the acquisition resolution. 
Possible values are defined in the type library file by the 
SelectionAcquisitionResolution enumeration: 

Acquisition Resolution Selection Value Comments 
SEL_RESOLUTION_1X 1 Acquisition Resolution – 1 × 
SEL_RESOLUTION_2X 2 Acquisition Resolution – ½ × 

4.8.4. GlobalDataCollection 
Property Type:  
VT_BOOL - global data collection 
Remarks: 
Enables or disables data collection and queries the value of the flag. 

4.8.5. AutoTracking 
Property Type:  
VT_BOOL - auto track 
Remarks: 
Enables or disables the auto track feature and queries the value of the flag. 

4.8.6. MagnificationFactor 
Property Type: 
VT_R4 – magnification factor 
Remarks: 
Gets or sets the external optics magnification factor. The range for the 
magnification factor value is between 0.01 and 1000. 

4.8.7. AngleUnits 
Property Type:  
VT_I2 – angle units 
Remarks: 
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Gets or sets the units used for reporting all the angles. Possible values are 
defined in the type library file by the SelectionAngleUnits enumeration: 

Angle Units Selection Value Comments 
SEL_ANGLE_UNITS_MRAD 0 Reports all the angles in miliradians 
SEL_ANGLE_UNITS_DEG 1 Reports all the angles in degrees 

4.8.8. ISOWidthMethod 
Property Type: 
VT_I2 - method for computing beam width 
Remarks: 
Gets or sets the method used for computing beam widths. 
If the 4Sigma method is selected, only the 1/e2 clip level beam width is 
computed. 
Possible values are defined in the type library file by the SelectionISOWidth 
enumeration: 

ISO Width Method Selection Value Comments 

SEL_ISO_D_SLIT 1 Slit method used for computing beam 
widths. 

SEL_ISO_D_ENERGY 2 Encircled energy method used for 
computing beam widths. 

SEL_ISO_D_4SIGMA 3 Second moment method (4Sigma) 
used for computing beam widths. 
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4.8.9. UseCliplevel 
Method Return Value: 
VT_EMPTY - none 
Method Parameter List: 
VTS_R4 - cliplevel in percentage 
VTS_BOOL - use 
Remarks: 
Enables beam width computation at the specified clip level. 
If the selected ISO method for computing the beam width is Energy, the 
beam energy should be used instead of the clip level.  
To enable beam width computation at a specified clip level, set the use flag to 
TRUE. To disable beam width computation at a specified clip level, set the 
use flag to FALSE. 
Without this function call, the beam width numbers returned from 
USBeamPro may not be valid. This function has to be called only once, at 
the beginning of the program, before any call to GetPeakWidth, GetEllipticity, 
GetEccentricity or GetPeakDivergence. 

4.8.10. GetWidth 
Method Return Value: 
VT_R4 - beam width 
Method Parameter List: 
VTS_I2 - axis 
VTS_R4 - cliplevel 
Remarks:  
Returns the beam width in microns. 
If the selected ISO method for computing the beam width is Energy, the 
beam energy should be used instead of the clip level. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 
If the selected ISO method for computing the beam width is Energy, then 
only one beam width number is computed. In this case, the beam width 
values for axis 0 and axis 1 are equal.  
If the selected ISO method for computing the beam width is 4Sigma, then 
only the beam width is computed. The specified “clip level” must be 1/e2. 
To enable beam width computations for the specified clip level, UseCliplevel 
has to be called before the first call to GetPeakWidth,  
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4.8.11. GetPeakPosition 
Method Return Value: 
VT_R4 - peak position 
Method Parameter List: 
VTS_I2 - axis 
Remarks: 
Returns the peak position in microns. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.12. GetCenter 
Method Return Value: 
VT_R4 - centroid position 
Method Parameter List: 
VTS_I2 - axis 
Remarks: 
Returns the centroid position in microns. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.13. GetPeakIrradiance 
Method Return Value: 
VT_I2 - peak irradiance 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns the irradiance of the peak. Possible values are 0…1023. 

4.8.14. EllipticAnalysis 
Property Type: 
VT_BOOL - elliptic analysis 
Remarks: 
Gets or sets the elliptical analysis flag. 
If this flag is TRUE, the elliptical analysis is enabled and GetRotationAngle, 
GetEllipticity and GetEccentricity will return valid numbers. 
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4.8.15. GetRotationAngle 
Method Return Value: 
VT_R4 - rotation angle 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns the orientation of the computed major axis in degrees. 
This function returns valid numbers only if elliptical analysis has been 
enabled, using EllipticAnalysis. 

4.8.16. GetEllipticity 
Method Return Value: 
VT_R4 - ellipticity 
Method Parameter List: 
VTS_R4 - cliplevel 
Remarks: 
Returns the ellipticity of the beam. 
If the selected ISO method for computing the beam width is Energy, the 
beam energy should be used instead of the clip level. In this case, the 
ellipticity will be 1, because there is only one beam width value. 
This function returns valid numbers only if elliptical analysis has been 
enabled, using EllipticAnalysis. Also the beam width computation for the 
specified clip level should have been enabled, using UseCliplevel, because 
the beam width numbers are used in the computation of the ellipticity. 

4.8.17. GetEccentricity 
Method Return Value: 
VT_R4 - eccentricity 
Method Parameter List: 
VTS_R4 - cliplevel 
Remarks: 
Returns the eccentricity of the beam. 
If the selected ISO method for computing the beam width is Energy, the 
beam energy should be used instead of the clip level. In this case, the 
eccentricity will be 0, because there is only one beam width value. 
This function returns valid numbers only if elliptical analysis has been 
enabled, using EllipticAnalysis. Also the beam width computation for the 
specified clip level should have been enabled, using UseCliplevel, because 
the beam width numbers are used in the computation of the eccentricity. 
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4.8.18. FlatTopAnalysis 
Property Type: 
VT_BOOL - flat top analysis 
Remarks: 
Gets or sets the flat top analysis flag. 
Flat top numbers will be computed over a Region of Interest that can be 
user-defined. 
If this flag is TRUE, the flat top analysis is enabled and GetFlatTopMin, 
GetFlatTopMax, GetFlatTopMean, GetFlatTopFlatness, GetFlatTopUniformity 
and GetFlatTopEnergy will return valid numbers. 

4.8.19. FlatTopThreshold 
Property Type: 
VT_R4 - flat top threshold 
Remarks: 
Gets or sets the threshold value (percentage of the peak pixel value) used for 
flat top analysis. 
The allowed range of the threshold is between 0 and 100. 

4.8.20. GetFlatTopMin 
Method Return Value: 
VT_I2 - flat top minimum 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns the minimum pixel value in the defined Region of Interest. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 

4.8.21. GetFlatTopMax 
Method Return Value: 
VT_I2 - flat top maximum 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns the maximum pixel value in the defined Region of Interest. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 
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4.8.22. GetFlatTopMean 
Method Return Value: 
VT_R4 - flat top mean 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns the mean value of all pixels in the defined Region of Interest. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 

4.8.23. GetFlatTopFlatness 
Method Return Value: 
VT_R4 - flat top flatness 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns the beam flatness in the defined Region of Interest. Flatness is 
defined as the ratio of the average to the maximum power density. The range 
is 0 -1 with 1 being a perfectly flat beam. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 

4.8.24. GetFlatTopUniformity 
Method Return Value: 
VT_R4 - flat top uniformity 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns the beam uniformity in the defined Region of Interest. Uniformity is 
defined as the normalized RMS deviation of power energy density from its 
average. A value of 1 indicates a completely uniform distribution having a 
profile with a flat top and vertical edges. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 
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4.8.25. GetFlatTopEnergy 
Method Return Value: 
VT_R4 - flat top energy 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns the total sum of the pixels inside of the defined Region of Interest. 
This function returns valid numbers only if flat top analysis has been enabled, 
using FlatTopAnalysis. 

4.8.26. GaussianFitAnalysis 
Property Type: 
VT_BOOL - Gaussian analysis 
Remarks: 
Gets or sets the Gaussian analysis flag. 
If this flag is TRUE, the 1-dimensional Gaussian analysis is enabled and 
Gaussian fit numbers can be computed using Get1dGaussianFit.  

4.8.27. Get1dGaussianFit 
Method Return Value: 
VT_R4 - Gaussian fit 
Method Parameter List: 
VTS_I2 - axis 
Remarks: 
Returns Gaussian fit numbers. 
This function returns valid numbers only if Gaussian analysis has been 
enabled, using GaussianFitAnalysis. 
Gaussian fit numbers are computed for the profiles that represent a pinhole 
scan through the data. In USBeamPro these profiles and their correspondent 
Gaussian fitted profiles can be visualized in the Profile view. 
Usually the pinhole data is obtained from a scan through the beam centroid. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 
If the user has moved the position of the cross hairs in the LiveVideo (either 
to peak, or to a user-defined point), the pinhole scan will go through the 
newly defined intersection of the two axes. The user can also change the 
rotation of the major and minor axes. 
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4.8.28. BackgroundCorrection 
Property Type: 
VT_I2 - background correction method 
Remarks: 
Gets or sets the method used for subtracting the camera background. 
Possible values are defined in the type library file by the 
SelectionBackgroundSubtraction enumeration: 

Acquisition Resolution Selection Value Comments 
SEL_BKGND_NONE -1 No background subtraction 
SEL_BKGND_FRAME 0 Frame subtraction 
SEL_BKGND_MEAN 1 Mean subtraction 

4.8.29. SetDivergenceMethod 
Method Return Value: 
VT_EMPTY - none 
Method Parameter List: 
VTS_I2 - divergence method 
VTS_R4 - distance 
VTS_R4 - cliplevel 
Remarks: 
Sets the divergence method and associated parameters used for the 
divergence calculation. 
If the selected ISO method for computing the beam width is Energy, the 
beam energy should be used instead of the clip level. 
Possible values for divergence method are defined in the type library file by 
the SelectionDivergenceMethod enumeration: 

Divergence Method Selection Value Comments 
SEL_DIV_METHOD_OFF 0 No divergence computations. 

SEL_DIV_METHOD_LENS 1 Lens method for computing 
divergence. 

SEL_DIV_METHOD_PTSRC 2 Point Source method for computing 
divergence. 

SEL_DIV_METHOD_NA 3 Numerical Aperture method for 
computing divergence. 
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The distance parameter represents the Focal Length if the Lens method has 
been selected, or the Distance from the Point Source if the method is Point 
Source or Numerical Aperture. 

4.8.30. GetDivergenceMethod 
Method Return Value: 
VT_EMPTY - none 
Method Parameter List: 
VTS_PI2 - divergence method 
VTS_PR4 - distance 
VTS_PR4 - cliplevel 
Remarks: 
Gets the divergence method and associated parameters used for the 
divergence calculation. 

4.8.31. GetDivergence 
Method Return Value: 
VT_R4 - divergence 
Method Parameter List: 
VTS_I2 - axis 
Remarks: 
Returns the divergence. 
Before measuring divergence, the divergence parameters should have been 
set using SetDivergenceMethod and the beam width computation should 
have been enabled for the specified clip level using UseCliplevel. 
The divergence is returned in mrad if the selected divergence method is 
Lens, degrees if the selected divergence method is PointSource and is 
unitless if the selected divergence method is NumericAperture. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 
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4.8.32. GetProfileData 
Method Return Value: 
VT_VARIANT - profile data array 
Method Parameter List: 
VTS_I2 - axis 
VTS_I4 - start index 
VTS_I4 - number of points 
Remarks: 
Returns an array of data points that represents a pinhole scan through the 
beam area. 
Usually the pinhole data is obtained from a scan through the beam centroid. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 
If the user has moved the position of the cross hairs in the LiveVideo (either 
to peak, or to a user-defined point), the pinhole scan will go through the 
newly defined intersection of the two axes. The user can also change the 
rotation of the axes. 
Start index represents the index in the pinhole scan data array that will 
correspond to the first data point returned. 
Number of points represents how many points will be copied in the returned 
array. 

4.8.33. GetProfileSampleSize 
Method Return Value: 
VT_R4 - sample size 
Method Parameter List: 
VTS_I2 - axis 
Remarks: 
Returns the sample size: the distance between two data points of the profile 
data array, in microns. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 
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4.8.34. GetProfileNumPts 
Method Return Value: 
VT_I2 - number of points 
Method Parameter List: 
VTS_I2 - axis 
Remarks: 
Returns the number of points in the profile data array, which is bound, by the 
beam area. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.35. GetSampleSize 
Method Return Value: 
VT_R4 - sample size 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns the dimension of one pixel from the data array, in microns. 

4.8.36. GetNumPts 
Method Return Value: 
VT_I4 - number of points 
Method Parameter List: 
VTS_I2 - axis 
Remarks: 
Returns the number of points inside the beam area. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 



Chapter 4.  Acquisition and Analysis Software 4.73 

Photon Inc.  B050909780-1.0 

4.8.37. GetTotalSize 
Method Return Value: 
VT_I4 - total size 
Method Parameter List: 
VTS_I2 - axis 
Remarks: 
Returns the dimension of the beam area, in microns. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.38. GetStartPos 
Method Return Value: 
VT_I4 - start position 
Method Parameter List: 
VTS_I2 - axis 
Remarks: 
Returns the distance from the edge of the camera chip to the beam area in 
microns. 
Possible values for the axis are 0 and 1. If elliptical analysis has been 
enabled (see EllipticAnalysis), 0 represents the major axis and 1 the minor 
axis. Otherwise 0 is the horizontal axis and 1 the vertical axis, where 
horizontal and vertical are relative to the camera. 

4.8.39. ImageRotation 
Property Type: 
VT_I2 – image rotation 
Remarks: 
Gets or sets the clockwise rotation of the image from the original frame. 
Possible values are 0, 90, 180 or 270. 
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4.8.40. ImageFlip 
Property Type:  
VT_I2 - image flip 
Remarks: 
Gets or sets the orientation of the image with respect to Vertical and 
Horizontal. Possible values are defined in the type library file by the 
ImageFlipSelection enumeration: 

Image Flip Selection Value Comments 
SEL_FLIP_NONE 0 Display the original frame 
SEL_FLIP_HORIZ 1 Flip the image about the horizontal axis 
SEL_FLIP_VERT 2 Flip the image about the vertical axis 

4.8.41. DoCalibration 
Method Return Value: 
VT_EMPTY - none 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Performs a calibration routine for the camera. 

4.8.42. IsCalibrated 
Method Return Value: 
VT_BOOL -  calibration status 
Method Parameter List: 
VTS_PDATE – date when the system calibration occurred 
Remarks: 
This method returns the calibration status of the system. 
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4.8.43. SetBeamArea 
Method Return Value: 
VT_BOOL – if Beam Area has been modified successfully 
Method Parameter List: 
VTS_R4 - left 
VTS_R4 - top 
VTS_R4 - right 
VTS_R4 - bottom 
Remarks: 
Sets a manual Beam Area. Turn AutoTrack off before you use this function, 
otherwise the Beam Area may change automatically while the software is 
trying to track the beam. The parameter list values are the coordinates of the 
Beam Area rectangle in microns, from the upper left corner of the array 
(which is (0,0)). If the Beam Area cannot be set (the coordinates are not 
within the array range), the return value is FALSE. If the Beam Area has 
been modified successfully, the return value is TRUE. 

4.8.44. GetBeamArea 
Method Return Value: 
VT_BOOL – Beam Area status 
Method Parameter List: 
VTS_PR4 - left 
VTS_PR4 - right 
VTS_PR4 - top 
VTS_PR4 - bottom 
Remarks: 
Gets the Beam Area coordinates. The parameter list values are the 
coordinates of the Beam Area rectangle in µm, from the upper left corner of 
the array (which is (0, 0) ). If there is no Beam Area the return value is 
FALSE. If there is a valid Beam Area the return value is TRUE. 

4.8.45. ComputationsDone 
Property Type: 
VT_BOOL – computations flag 
Remarks: 
Gets or sets the status of the frame computation. If this flag is TRUE that 
means that at least one frame was acquired and processed. Set this flag to 
FALSE before initiate a data acquisition and then wait until the state is TRUE 
in order to be sure a new frame was acquired and processed. 
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4.8.46. Recompute 
Method Return Value: 
VT_EMPTY - none 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Redo computations for selected parameters based on the current settings. 
Computations are done on the image data that is currently in memory. 

4.8.47. GetTotalEnergy 
Method Return Value: 
VT_R4 - total energy 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns total sum of the pixels inside of the defined Beam Area. 

4.8.48. IsSaturated 
Method Return Value: 
VT_BOOL – saturation flag 
Method Parameter List: 
VTS_NONE - none 
Remarks: 
Returns TRUE if signal is saturated, FALSE otherwise. 

4.8.49. ShowWindow 
Property Type: 
VT_BOOL – Show flag 
Remarks: 
Shows or hides the USBeamPro Analysis Software main window. Call this 
function with FALSE as parameter to hide the USBeamPro Analysis 
Software. Call this function with TRUE if you want to show the USBeamPro 
Analysis Software. 
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4.8.50. ProfileType 
Property TYpe 
VT_I2 - profile type 
Remarks: 
Gets or sets the profile types, either Pinhole or equivalent Slit. The value set 
with this function will impact the arrays obtained by GetProfileData method. 
Possible values are defined in the type library file by the ProfileTypeSelection 
enumeration: 

Profile Type Selection Value Comments 
SEL_PROFILE_PINHOLE 0x00 Pinhole profiles through the crosshairs. 
SEL_PROFILE_SLIT 0x01 Equivalent slit profiles. 

4.8.51. Get2DData 
Method Return Value: 
VT_VARIANT - 2D data array 
Method Parameter List: 
VTS_R4 - left 
VTS_R4 - top 
VTS_R4 - right 
VTS_R4 - bottom 
VTS_I2 - decimation 
Remarks: 
Returns a 2D-array (matrix) of data points representing the 2D intensity data 
(values between 0 and 1023). The first four values from the parameter list 
are the coordinates of the rectangle area from where the data is exported, in 
µm, the coordinates are reported from the upper left corner of the array 
(which is (0, 0)). The decimation value can be used to read out a smaller 
array of data and it is used in both lines and columns of the matrix (transfer 
every nth pixel on every nth line, where n is the decimation value). 
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4.8.52. CameraExposure 
Property Type 
VT_R4 – camera exposure 
Remarks: 
Gets or sets the exposure time for the camera, in ms. The range for the 
exposure value is from 0.03 to 30. 

4.8.53. Averaging 
Property Type 
VT_I2 – average value 
Remarks: 
Gets or sets the number of frames used in averaging. The range for the 
average value is between 1 and 1000. 

4.8.54. ProfileCrossHairsType 
Property Type 
VT_I2 – profile cross hairs 
Remarks: 
Gets or sets profile cross hairs type. If the Profile Type is set to Slit 
(Equivalent Slit Profiles) the only option available is Centroid.  
Possible values are defined in the type library file by the 
SelectionProfileCrossHairsType enumeration: 

Profile Cross Hairs Selection Value Comments 
SEL_XHAIR_CENTROID 0 Cross hairs through the centroid 
SEL_XHAIR_PEAK 1 Cross hairs through the peak 

SEL_XHAIR_USERDEF 2 Cross hairs through a user 
defined position 
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4.8.55. SetProfileCrossHairsPos 
Method Return Value: 
VT_BOOL – if position for profile Cross Hairs has been modified successfully 
Method Parameter List: 
VTS_R4 - posHoriz 
VTS_R4 - posVert 
Remarks: 
Sets the position (horizontal and vertical) for the user defined crosshairs, in 
microns. This method can be called only if the Profile Type is set to Slit 
(Equivalent Slit Profiles). 

4.8.56. GetProfileCrossHairsPos 
Method Return Value: 
VT_BOOL – if position for profile Cross Hairs has been retrieved successfully 
Method Parameter List: 
VTS_PR4 - posHoriz 
VTS_PR4 - posVert 
Remarks: 
Retrieves the position (horizontal and vertical) for the crosshairs, in microns. 

4.8.57. SaveFrameAsTIFF 
Method Return Value: 
VT_BOOL - Save Flag status 
Method Parameter List: 
VTS_BSTR - file full name (with qualified path if necessary) 
Remarks: 
Saves the current frame (raw image) as an uncompressed 16-bit TIFF file. If 
the operation was successful, the method returns TRUE, otherwise returns 
FALSE. 
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4.8.58. GetCameraList 
Method Return Value: 
VT_VARIANT – array of strings; each string uniquely corresponds to a 
camera present on the system 
Method Parameter List: 
VTS_NONE – none 
Remarks: 
Call this property to retrieve the number of cameras present on the system, 
and for each camera the uniquely associated corresponding string. The first 
element in the array always corresponds to the camera that is currently used 
by the USBeamPro software. These strings need to be passed as parameter 
to SelectCamera method in order to select a specific camera. 

4.8.59. SelectCamera 
Method Return Value: 
VT_BOOL – Camera selection status 
Method Parameter List: 
VTS_BSTR – Camera identifier 
Remarks: 
Selects a different camera for use with the USBeamPro software. To select a 
camera pass the uniquely associated string with the camera that was listed in 
the GetCameraList method. 

If the operation was successful, the method returns TRUE, otherwise returns 
FALSE. 

After a new camera was selected the system is not calibrated and the global 
data collection is turned off.  

4.8.60. Example files 
In the Automation folder under the folder where the software has been 
installed (the default settings is “C:\Program Files\Photon\USBeamPro”) 
there are two detailed examples about using ActiveX: one written in Visual 
Basic for Application (VBA) using Microsoft Excel “USBeamPro ActiveX 
Example.xls” and one developed in LabVIEW “USBeamPro ActiveX 
Example.vi”. 
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55..  FREQUENTLY ASKED 

QUESTIONS 
Q1. The following questions all pertain to the 

measurement of energy or power in your laser beam. 
Please refer to the answer below: 
♦ How do I measure energy/power in my beam? 
♦ How do I measure the energy/power in a section of my beam? 
♦ What does "ROI" mean? 
♦ How do I set the region of interest? 
♦ How do I change the energy units from CNT to something  

meaningful? 
♦ How do I measure fluence? 
♦ How do I measure peak intensity in meaningful units? 
♦ What does Uniformity mean? How is it calculated? 
♦ What does Flatness mean? How is it calculated? 
♦ How do I measure power density? 
♦ How can I measure the energy contained in a satellite beam? 
♦ How can I measure the energy in two equal sized areas within 

my beam? 
♦ How can I move the selected region of interest without 

changing it's size? 

Energy/Power measurements can be made on any area or region of your 
laser beam, (Energy measurements are made on pulsed beams, whereas 
Power measurements are made on CW beams.) 
To perform this measurement, select "Flat Top Analysis" in the Data 
Analysis dialog box accessed from the Data Collection Menu. 
The units of the energy/power analysis are also selected under the Data 
analysis dialog. Units available are: mW, mW, W, for CW beams or mJ, mJ, J, 
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for pulsed beams. When selected, the Energy/Power parameter values will 
be displayed in the appropriate MKS units. 

1. Define an area, called the Energy Region of Interest (Energy 
ROI), using the drawing tools in the Video window. The 
drawing tools can be accessed either through the Options 
menu or by using the four yellow icons on the Video window 
toolbar. If using the menus, select "Overlays" from the Options 
menu. Another menu will appear. Then, select "Energy ROI" to 
obtain the final menu where you must select one of the four 
area types: Circular, Elliptical, Square, Rectangular. If using 
the icons, simply click on the icon of the desired area type.  
(Note: If icons are “grayed out”, Flat Top Analysis is not on.) 

2. Draw a ROI. Using the mouse, position the cursor at one 
"corner" of your desired area, hold down the left mouse button 
and drag the mouse to the opposite "corner". (For circular and 
elliptical areas, the "corners" are the points at which tangents 
of the area perimeter, aligned along the principal axes, 
intersect.) As you draw, you will see a "fat" outline of the area 
selected. Release the mouse to "freeze" the outline. The ROI 
can be drawn only inside the Beam Area!  

3. If the area is not exactly what you want, you can now use the 
mouse to change the selected area, or you can draw a new 
area as in Step #3 above. 

4. Once you are satisfied with the selected area, you must 
perform steps to validate your selection. You can validate your 
selection in 2 ways: 

a. From the Options menu, select "Energy ROI" and click on the 
area type that was drawn. Or,  

b. From the toolbar, click on the Area icon for the area you -
selected. The energy ROI has now been defined. All Flat Top 
Analysis will be performed only in this portion of the Video 
Image. 

5. You can move the ROI to different locations, and then use the 
Recompute feature to analyze the energy in the new locations. 
If you want to use the exact same area used previously, 
simply select the "drawing" tool, then while pressing the CTRL 
key on your keyboard, use the mouse to drag the ROI to the 
new location.  

Displaying the Energy ROI in the Video window:  
This feature is optional. An overlay of the selected Energy ROI 
can be displayed on the Video Screen if the user desires; or, 
the overlay can be left invisible. This option is available under 
Options, Overlays, Energy ROI. 
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6. Definitions of Uniformity and Flatness 

  The beam Uniformity is defined in the ISO Standard as:  

 

  

 

  The beam Flatness Factor is defined in the ISO Standard as: 

 

 

Q2. How do I automatically follow a moving beam? 
To automatically "follow" a moving beam, use the Auto Track feature. This 
feature is available either under the Data Collection Menu or by clicking the 
Auto Track icon on the main toolbar. When selected, the software 
determines an area, called the "Beam Area", in which profile calculations will 
be performed. 

Q3. How do I measure the "short and long" beam 
diameter and determine the beam rotation in an 
elliptic beam? 

To determine the "long" and "short" diameters of your beam, and the rotation 
of your beam, select "Elliptical Analysis" in the Data Analysis dialog box. 
When "Elliptical Analysis" is enabled, beam calculations will be performed to 
determine the major and minor axes, the beam ellipticity (the ratio of the 
1/e2 (13.5%) widths of the major and minor axes) and the tilt angle (angle 
with respect to horizontal) of the major axis. The elliptical parameters can be 
displayed in the Beam Statistics Parameters dialog. 

Q4. How do I subtract the background noise? 
To subtract background noise, you must first perform a calibration to 
generate a background calibration factor. This is done through the 
Calibration dialog box accessed under the Data Collection menu. Also, the 
system must be operating in the Analysis mode. A new calibration file is 
generated whenever you perform a calibration. 
Two types of background subtractions are available; either "frame" or 
"mean". The selection is available under the Data Collection menu by 
selecting "Background Subtraction". The choice is available because some 
cameras have very non-uniform backgrounds and some ambient 
background conditions are also non-uniform. In cases like these, "Frame 
Subtraction" is recommended. You may also want to use "Frame 
Subtraction" for very small beams. The choice is yours. 
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The background in the calibration file is automatically subtracted from your 
data. It is important to perform calibrations periodically to ensure that the 
stored background file is appropriate for your present condition. The 
background can change significantly due to changes in attenuation and 
room lighting, or for such things as subtle as the brightness of the shirt you 
wear. 

Q5. How do I measure my pulsed beam? 
There are two ways to measure pulsed beams. The best way is to use the 
External Trigger Mode, available under the Data Collection menu by 
selecting Trigger Mode. You must supply an external TTL level signal to the 
external input trigger BNC connector on the Image Capture Card. A trigger 
cable is available from Photon, inc. as Option /TRG or you can make one 
yourself. 
If you cannot provide an external trigger, use the Pulsed Trigger mode, also 
available under the Data Collection, Trigger Mode sub-menu. When this 
mode is selected, the software will automatically determine the presence of 
the beam based on a minimum signal amplitude of 32 counts out of 4096, 
i.e., 3.125% full scale. In this mode, the update rate will, in general, be 
reduced. Do not select External Trigger if one is not present.  

Q6. How do I draw/measure a Gaussian fit? 
A Gaussian fit can be calculated by selecting "Gaussian 1D" in the Data 
Analysis dialog box. The fit is calculated according to the ISO Standard. 
Once the fit calculation is enabled, an overlay can be drawn over the beam 
profiles in the Profile window. This is accomplished either through the Profile 
window option menu or by clicking on the "Gaussian Fit Overlay"  icon on 
the Profile window toolbar. The Gaussian Fit Parameter can be reported in 
the Beam Statistics window. 

Q7. How do I measure peak intensity? 
To measure peak intensity, open the Beam Statistics Parameter dialog box, 
available under the options menu for the Beam Statistics window option 
menu, or by clicking the "Parameter"  icon on the Beam Statistics window 
toolbar. Select "Peak" to display the peak intensity (in counts) in the Beam 
Statistic Parameter dialog. 

Q8. How do I set or display beam area? 
The Beam Area is set in one of two ways. The simplest way is to click on the 
beam area drawing tool icon on the Video window toolbar. Then use the 
mouse to draw a rectangular region in the Video window. (Note that the 
software must first be operating in the Analysis mode). To draw, place the 
mouse at one corner of your desired area; then hold down the left mouse 
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button and drag the mouse to the opposite "corner". As you draw, you will 
see a "fat" outline of the area selected. Then, to set the area, click the beam 
area icon again. The Beam Area outline will now appear as a thin line. The 
second method is to select the Beam Area drawing tool from the Options 
menu of the Video window. 
Displaying the beam area is optional. To display the beam area, select 
"Beam Area" from the Overlays sub-menu in the Options menu. 

Q9. How do I know the size of the beam area? 
The size of the Beam Area used for all computation is displayed on the 
Status Bar at the lower right corner of the screen. The upper left coordinate 
and size of the rectangle are shown in microns. 

Q10. How do I monitor my laser over long periods? 
There are two ways to monitor your laser over long periods of time. This is 
done using either the Beam Statistics window or the Time Statistics window. 
(You can open up to 15 Time Statistic windows) You can select the windows 
under the windows menu or by clicking the icon on the main toolbar. You 
must define the parameter that you wish to display. This can be done in the 
Parameter dialog box, accessed either from the Options menu or by clicking 
on the   icon on the local toolbar. 

Q11. How do I add my notes to the data that I just 
collected? 

Notes can be appended to your data by using the Notes window. The Notes 
window can be opened either through the windows menu or by clicking on 
the Notes window icon from the main toolbar. Use the Notes window like 
any text editor. 

Q12. How can I print the data I collected? 
There are several ways to print hard copies of your data. You can either use 
the Print feature under the File menu or you can save your screen as an 
image file (either bitmap, JPEG, Tiff, Giff or PNG file) and copy it to another 
program and print. 

Q13. What options do I have for saving and outputting 
data? 

There are many ways to save your data. You can save screens with data, 
save screens as an image file, raw pixel data files, or you can log data to 
files. The save options are available from the "Save" or "Save As" selection 
under the file menu. The data logger options are accessed from the Beam 
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Statistics Parameter dialog box under the Options menu of the Beam 
Statistics window. 

Q14. What statistics can be calculated? 
Statistical quantities available are the Mean, Min, Max and Standard 
Deviation. These selections are made through the Beam Statistics 
Parameters dialog box available under the Options Menu of the Beam 
Statistics window. 

Q15. How do I profile through a different cross section? 
You can profile through a different cross section by moving the Cross Hairs 
in the Video window (the profiles are displayed in the Dual Aperture Profile 
window). This is done with the mouse by grabbing the cross hair (click on 
the left mouse button) and dragging to a new location. 

Q16. How do I profile through a different cross hair 
rotation? 

To change the rotation of the cross hair, the system must be operating in the 
Elliptical Analysis mode available from the Data Analysis dialog box under 
the Data Collection menu. Grab one of the axes by left clicking on the 
mouse, and while simultaneously holding down the "Ctrl" key, use the 
mouse to drag the cross hair to a different rotation. 

Q17. Why can't I see the cross hairs? 
If the cross hairs are not visible in the Video window, then the cross hair 
display feature has been turned off. They can be displayed from the Options 
menu under the Overlays sub-menu by selecting "Cross Hairs". 

Q18. How do I remove the cross hairs? 
To turn off the cross hair display in the Video window, go to the Options 
menu under the Overlays sub-menu and "deselect" the "Cross Hairs" option. 

Q19. How can I change the clip levels? 
If in the Data Analysis dialog box, under the Data Collection menu, the 
analysis method for ISO profiles is set to “D slit”, clip levels of 13.5%, 36.8%, 
50%, 60.7% and one user level are available under the Beam Statistics 
Parameter and/or Time Statistics Parameter dialog boxes, available by 
selecting the clip level of choice under "Beam Width". If you selected "User 
%", then you must also enter the clip level value.  
If in the Data Analysis dialog box, under the Data Collection menu, the 
analysis method for ISO profiles is set to “D energy”, clip levels of 86.5%, 
63.2%, 50%, 39.3% and one user level are available under the Beam 
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Statistics Parameter and/or Time Statistics Parameter dialog boxes, 
available by selecting the clip level of choice under "Beam Width". If you 
selected "User %", then you must also enter the clip level value. 
If in the Data Analysis dialog box, under the Data Collection menu, the 
analysis method for ISO profiles is set to D 4sigma, there is no selection for 
clip levels. 

Q20. How do I customize the screen? 
You can customize the screen in the usual Windows feature by sizing and -
arranging windows or by using the Cascade and Tile Feature available 
under the Windows menu. 

Q21. How do I zoom in on the beam? 
You can "Zoom In" on the beam displayed in the Video window by selecting 
"Zoom" under the Options Menu. Choices available are: 1:2× 1×, 2×, 4×, 8×, 
16× and Fit to window (proportional to the camera array dimension). 

Q22. How do I customize the color scheme? 
The color scheme of 2D and 3D displays can be customized under the Clip 
Level dialog box available under the options menu for each applicable 
window. 
The color scheme of Video can be customized under the Select colors item 
from the Options menu. 

Q23. How do I normalize the graphs? 
The profiles displayed in the Profile window can be normalized (expand the 
display to show a peak value of 100%) either from the options menu or by 
clicking on the Normalize Icon on the local toolbar. If the Profile mode is set 
to Slit, the profiles are always normalized. 

Q24. How can the toolbar buttons save me time? 
The toolbar buttons save you time by affording you immediate access to 
selected features. They eliminate the time required to access these features 
through the various menus and sub-menus. 
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